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HYBRID ARTS, INC. LICENSE AGREEMENT

IMPORTANT:

READ THIS PAGE BEFORE USING THE
ENCLOSED SYSTEM OR BREAKING THE
SEAL ON THE SOFTWARE DISKETTE
SHUTTER. THE SOFTWARE, HARDWARE,
AND OWNERS MANUAL (SYSTEM)
CONTAINED HEREIN IS LICENSED IN
ACCORDANCE WITH THE FOLLOWING
TERMS AND CONDITIONS.

Hybrid Arts grants to you a personal
license to use the enclosed Hybrid Arfs
System solely for your own internal
needs.

LICENSE
You May:
a. use the system on a single machine;

b. copy the program into any machine-
readable or printable form for
backup or modification purposes in
support of your use of the program
on the single machine. (Certain
programs, however, may include
mechanisms to limit or inhibit copying.
They are marked “copy protected’.)

c. transfer the program and license to
another party if the party agrees to
accept the terms and conditions of
this Agreement. If you transfer the
program, you must, at the same time,
either transfer all copies whether in
printed or machine-readable form to
the same party, or destroy any
copies not transferred:; this includes all
modifications and portions of the
program contained or merged into
other programs.

You must reproduce and include the
copyright notice on any copy,
modification or portion merged into
another program.

YOU MAY NOT USE, COPY, MODIFY, OR
TRANSFER THE SYSTEM, OR ANY COPY,
MODIFICATION OR MERGED PORTION,
IN WHOLE OR IN PART, EXCEPT AS
EXPRESSLY PROVIDED FOR IN THIS
LICENSE. IF YOU TRANSFER POSSESSION
OF ANY COPY, MODIFICATION OR
MERGED PORTION OF THE SYSTEM TO
ANOTHER PARTY, YOUR LICENSE IS
AUTOMATICALLY TERMINATED.

IERM

The license is effective until tferminated.
You may terminate it at any other time
by destroying the system together with
all copies, modifications and merged
portions in any form. It will also terminate
upon conditions set forth elsewhere in this
Agreement or if you fail to comply with
any terms or conditions of this
Agreement. You agree upon such
termination to destroy the system
together with all copies, modifications
and merged portions in any form.

ITED W,

THE SYSTEM IS PROVIDED °“AS IS*
WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE.
THE ENTIRE RISK AS TO QUALITY AND
PERFOMANCE OF THE SYSTEM IS WITH
YOU. SHOULD THE SYSTEM PROVE
DEFECTIVE, YOU (AND NOT HYBRID ARTS,
INC., OR AN AUTHORIZED DEALER)
ASSUME THE ENTIRE COST OF ALL
NECCESSARY SERVICING, REPAIR, OR
CORRECTION.

Hybrid Arts, Inc.™
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SOME STATES DO NOT ALLOW THE
EXCLUSION OF IMPLIED WARRANTIES, SO
THE ABOVE EXCLUSION MAY NOT APPLY
TO YOU. THIS SOFTWARE GIVES YOU
SPECIFIC LEGAL RIGHTS AND YOU MAY
ALSO HAVE OTHER RIGHTS WHICH VARY
FROM STATE TO STATE.

Hybrid Arts, Inc. does not warranty that
the functions contained in the system will
meet your requirements or that the
operation of the system will be
uninterrupted or error free. Hybrid Arts,
Inc. may from time to time, revise the
performance of its system and in doing
s0, incur no obligation to furnish such
revisions to you.

However, Hybrid Arts warrants the
diskette(s) on which the program is
furnished and the harware to be free
from defects in materials and
workmanship under normal use for a
period of ninety (90) days from the date
of delivery to you as evidenced by a
copy of your receipt.

LIMITATIONS OF REMEDIES

Hybrid Arts, Inc. entire liability and your
exclusive remedy shall be:

1. the replacement of any diskette or
hardware not meeting Hybrid Arts
‘Limited Warranty" and which is
returned to Hybrid Arts, Inc. or an
authorized dealer with a copy of your
receipt,

or:

2. if Hybrid Arts, Inc. or the dealer is
unable to deliver a replacement
diskette or hardware which is free of
defects in materials or workmanship,
you may terminate this Agreement by
returning the program and your
money will be refunded.

IN NO EVENT WILL HYBRID ARTS, INC. BE
LIABLE TO YOU FOR ANY DAMAGES,
INCLUDING ANY LOST PROFITS, LOST
SAVINGS OR OTHER INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT
OF THE USE OR INABILITY TO USE SUCH
SYSTEM EVEN IF HYBRID ARTS OR AN
AUTHORIZED DEALER HAS BEEN ADVISED
OF THE POSSIBILITY OF SUCH DAMAGES,
OR FOR ANY CLAIM BY ANY OTHER PARTY.

SOME STATES DO NOT ALLOW THE
LIMITATION OR EXCLUSION OF LIABILITY
FOR INCIDENTAL OR CONSEQUENTIAL
DAMAGES SO THE ABOVE MAY NOT APPLY
TO YOU.

GENERAL

You may not sublicense, assign or
transfer the license or the program
except as expressly provided in this
Agreement. Any attempt otherwise to
sublicense, assign or transfer any or the
rights, duties or obligations hereunder is
void.

YOU ACKNOWLEDGE THAT YOU HAVE
READ THIS AGREEMENT, UNDERSTAND IT
AND AGREE TO BE BOUND BY ITS TERMS
AND CONDITIONS. YOU FURTHER AGREE
THAT IT IS THE COMPLETE AND EXCLUSIVE
STATEMENT OF THE AGREEMENT BETWEEN
US WHICH SUPERCEDES ANY PROPOSAL
OR PRIOR AGREEMENT, ORAL OR
WRITTEN, AND ANY OTHER
COMMUNICATIONS BETWEEN US
RELATING TO THE SUBJECT MATIER OF
THIS AGREEMENT.

Hybrid Arts, Inc.™
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CHAPTER 1
INTRODUCTION

In This Chapter:

e Program Overview
e About This Manual
¢ System Requirements
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PROGRAM OVERVIEW

EZ-Track Plus is a 20-track sequencer that provides any musician with the
most flexible and powerful music production system available for the Atari
personal computer system. This overview is simply intended to give you an
idea of what's in store for you as you learn to use EZ-Track Plus. Because it
is a powerful package, it means there is a lot to learn. Fortunately, the
interface built into the program is very easy to operate, giving you a variety
of ways to tell the computer just what you want it to do for you. To get the
most out of this program, you should invest some time in leaming how to
use it. The rewards of learning the power of this package will become more
evident each time you sit down to write some music, and as the commands
become second nature to you, the speed with which you produce will
impress you.

EZ-Track Plus is primarily laid out like a multi-track tape recorder; linear
sequencing, in other words. Each track functions quite like what you'd find
in a 4-track or 8-track machine, except now you have 20 digital tracks. You
can record music in much the same way: keyboards on one track, bass on
another, kick on a third, etc., overdubbing as you go. Tracks can be muted,
bounced, or just about anything you'd normally do with an analog tape
deck.

Bear in mind a basic understanding of MIDI and the instruments you own:
each key or button of your instrument (drum machines included) is like a
light switch. Those switches are used to turn notes ON and OFF, no matter
what sound is set to be played.
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When you play a MIDI instrument, the sequencer remembers what time
you play which note (switch) and how long you hold the note (or keep the
switch pressed ON). When the sequencer plays back, it electronically makes
the same notes (switches) turn ON and OFF at the time you manually
played them, relative to the starting time of the sequencer.

If your instrument can only play one sound at a time, that's all EZ-Track
Plus can play. But if your instrument can play more than one sound at
once (for example, a flute, trumpet, piano, strings, etc.) then the sequencer,
when set properly, can also play those different sounds.

EZ-Track Plus has a variety of options available to you. There are hundreds
of options; however, you only need to learn a few to get started. And all the
features are always available to you, with no need to memorize any
complicated key strokes or involved commands. Use the mouse to point,
click, and select the functions.

EZ-Track Plus is an extremly powerful music tool. Both the program and
the manual are written in an easy interactive style. We hope this piece of
software will be easy to learn. We're sure you'll enjoy the music EZ-Track
Plus lets you create.
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ABOUT THIS MANUAL

Why Use This Manual

The reason for an owner's manual is obvious: it provides the necessary
information to operate a machine, or in this case, a sophisticated piece of
software. EZ-Track Plus is an easy program to use; most functions can be
figured out intuitively, without a need to reference the manual at all.
However, there may come a time when you really want to discover the full
power of EZ-Track Plus, or you need a greater understanding of one feature
or another, so a good operations manual is helpful. This manual has been
written to complement the ease of use of the program, providing insight and
depth for every feature but presenting it in such a way that having'a degree
in computer science isn't necessary to figure it out.

You are the one learning to use EZ-Track Plus, and the time you invest in
fully understanding how this tool works translates into how effectively you
can make it work for you. Or how much fun you're going to be able to have
with it.

How This Manual Is Organized

This manual has been organized so you can learn about the EZ-Track Plus
program quickly and easily. Each chapter is organized with a step-by-step
learning process in mind. The manual starts out explaining basic
operations (Setup, Recording, Track Copying), and goes on to explain more
advanced features (Glue Section, Velocity Adjust, MIDI Synchronizing).

At the start of each chapter there is also a key word list: words and terms
used in the chapter that are important to fully understand the material
contained within it. It's a good idea to review these terms before reading the
chapter for the first time so that you'll have a good grasp of the fundemental
words involved.
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The Table Of Contents lists the appendices that appear at the end of the
manual. These are labeled after a prominent letter of the Appendix name so
you can easily remember their contents: Appendix A - Application Notes, G -
Glossary, K - Key Command Summary, and R -- Menu Bar Reference. There
are no missing pages or sections.

A detailed index and complete glossary of terms can be found at the end of
the manual.

This manual assumes a basic knowledge of the Atari ST. If you haven't yet
done so, please familiarize yourself with the ST owner’'s manual.

Suggested Study Habits

In studying the information in this manual, do not go beyond words you
don't fully understand. There is an extensive glossary at the end of the
manual containing the technical terms you'll find within these pages as well
as a list of words used within the subject of electronic music.

You're going to be learning a very sophisticated piece of software, and the
application of good study habits will go a long way in making the most of the
time you're about to invest. If you come across a word you do not fully
understand, look it up in the glossary or a regular dictionary, then restudy
the materials. You'll find things start making a whole lot more sense very
quickly. Although it may take a little extra time to clear up technical terms,
you'll find your progress speeds up as you go.
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SYSTEM REQUIREMENTS

To get your system working, you must first have the following items.

Required:
¢ Atari 520ST, 1040ST or a MEGA personal computer
e Color or Monochrome Monitor
(The program works in either Medium or High resolution)
¢ One disk drive (Single or Double Sided)
e At least one MIDI-equipped instrument
¢ An audio playback system or set of headphones
¢ An EZ-Track Plus disk
¢ 2 or more MIDI cables

The following are optional items that help the system to work more
effectively.

Optional:

¢ Additional MIDI-equipped instruments and MIDI cables

e An additional disk drive

e Hard Disk drive (for speed and storage)

¢ Additional RAM (internally in the computer. See your Atari Dealer)
* Battery Backup clock (pre-packaged within MEGA computers)

Note:
EZ-Track Plus does not play music through the internal sound chips of the
Atari ST.
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GETTING STARTED

In This Chapter:

Checking Your Package
Making A Backup
Connecting Your System
Loading EZ-Track Plus
Recording Music
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Key Words:

e Buffer

e Interface

e MIDI In/Out/Thru
e Overdub
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CHECKING YOUR PACKAGE

Package Contents
Your EZ-Track Plus package should contain:

e The EZ-Track Plus Manual
e The EZ-Track Plus Master Disk
¢ Registration & Warranty Card

If your package is not complete, call your Hybrid Arts dealer or supplier.
Before going any further, PLEASE fill out your warranty/registration card
and mail it in. This is IMPORTANT so that we can notify you regarding
future upgrades to EZ-Track Plus, and so that you can call Hybrid Arts
Technical Support for assistance with the program.

Disk Contents

The Master Disk contains your EZ-Track Plus program. It contains the
following files:

AUTO (A folder containing EXACTIME.PRG which sets your clock to the
correct time when you reset the computer.)

CONTROL .ACC Control Panel Accessory

GENPATCH .ACC GenPatch Accessory

DESKTOP .INF

EZIRACK+ .PRG EZ-Track Plus program

EZTP .REL

There are also some songs on your disk provided for your listening pleasure. These can
be studied and used as introductory examples.

The disk has been set to write protect ON (the tab is positioned so you can
see through the hole). This is set ON so that the information on the disk
can't be erased by mistake.
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MAKING A BACKUP

The EZ-Track Plus disk is not copy protected. This is for your convenience
so that you can make a personal copy for backup use. If something should
happen to your disk, you can replace it with your backup copy.

This is also so that you can copy the program to your hard drive. You can
run this program from your hard drive without worrying about having a
key disk in Drive A.

Before you begin, you should make a backup copy of your disk and use this
backup as your working copy, storing the original in a safe place.

To Format A Disk Single-Sided (from the DESKTOP):

* Insert a blank disk in drive A

¢ Click once on FLOPPY DISK A (it inverts)

¢ Select Format from the File menu

e Format the disk Single-Sided

e The number of bytes on a Single-Sided disk is 357376. If this number
matches the number on the screen after the formatting is complete, the
disk has been properly formatted.

¢ Click OK

¢ Click EXIT (to exit from the Format program)

Blank
Formatted
Disk
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Follow these steps to make a backup disk of EZ-Track Plus:

To Make A Backup (Using 1 Disk Drive):
¢ Format a disk Single-Sided
¢ Insert your EZ-Track Plus Master Disk in drive A
¢ Click on FLOPPY DISK A once and hold the left mouse button
¢ Drag Drive A over to Drive B until Drive B inverts
¢ Let go of the mouse button
* An Alert box appears explaining that doing this will erase all of the
information on FLOPPY DISK B
¢ Click OK
¢ This runs an Atari disk copy program
e When prompted to swap disks:
SOURCE is your Master Disk (Disk A)
DESTINATION is your newly formatted blank disk (Disk B)
* Click COPY
» Disk A will be copied to Disk B
¢ When the Disk Copy program returns, Click EXIT

(If you have another disk copy program, follow the instructions for that
particular program.) MAKE SURE TO LABEL YOUR BACKUP DISK.

If you have a hard disk drive, you can copy EZ-Track Plus to it without any
problems. If you put the program into its own folder, make sure you put the
necessary accessories outside the folder on the correct directory. If you
BOOT off of a Hard Disk Boot Disk, make sure you have accessories on Drive
A or Drive C -- not both. If your hard disk is set to AUTO-BOOT, you must
have your accessories on the root directory of Drive C.
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CONNECTING YOUR SYSTEM

In order to hear any music from EZ-Track Plus you'll need to connect it via
MIDI to an external synthesizer. The basic hookup requires two MIDI
connections: the MIDI Out of your synthesizer to the MIDI In of the ST and
vice versa.

Basic EZ-Track Plus Hookup:

A

%\mg}w Synthesizer
__I3]]|8s
WY/

//I///I////ATARIST
TOCOCICICICICICICICIE
1 I I LT

] i il ulluuuuuuuH

o uiw
-
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LOADING EZ-TRACK PLUS

The EZ-Track Plus disk contains information neccessary for starting the
computer and loading it with the proper Accessories associated with your
EZ-Track Plus program.

The Desk Accessories are loaded when the computer is _first turned ON. The
disk in the main drive (usually drive A by default) is where the accessories
are loaded from. If the disk doesn't have any accessories, NONE WILL BE
LOADED. To reload new accessories, turn the computer OFF, insert a disk
with the proper accessories on it, then turn the computer ON.

To Load EZ-Track Plus:

e Insert your EZ-Track Plus disk in drive A

e Turn the computer ON

e After a while, a "desktop" appears and you should see a listing of what is
on the disk (The listing is called the Directory and each item in the
Directory is called a File)

¢ Click on the file named EZTRACK+.PRG once

DESKTOP INF 456 04-22-88
EZTP  REL 195470 04-22-88
5SONGS SNG 81198 84-22-88

¢ Select Open from the File menu m
S

EZ-Track Plus is now loading. This process is MJEE,}EE::.'.W
signified by EZTRACK+.PRG displayed at the New Folder
title line at the top of the screen and a Busy Bee P

i Close
hard at work loading the program for you. Close Window

e ane e o B0 000 200 AP NP 00 0 B0 0 00 0

Farnat. ..
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RECORDING MUSIC

If you have an instrument correctly connected to the MIDI ports of the
Atari, EZ-Track Plus will record anything you play on that instrument.

To Record Music:
¢ Click on the PLAY button

If you have your monitor sound up, you'll hear a metronome

EI start counting at a tempo of 120 beats per minute (the
default tempo). You'll see the little metronome icon begin
ticking

¢ Play some notes on your instrument

* As soon as you press any key on your instrument, the KEEP button will
become highlighted. This means that EZ-Track Plus has received some
MIDI information and is storing it in the Record Buffer.

e As soon as you're done playing, click on the STOP button

Whatever you have played is stored within the Record
Bulffer, and you'll need to assign this information to a track.

E Unlike a traditional Multi-Track recorder, you select the
track AFTER you've recorded some music.
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To the left of your screen you'll see a column of numbers from 01 to 20.
These are the 20 tracks you can record on. Directly to the left of number 01
you can see a small arrow, which is an indicator to show you which track
you are about to access.

Since it's already pointing to track 01, we'll save our music
»01: there.

To Save What Is In The Record Buffer:
¢ Select an empty track to save on (track 01 is initially selected)
¢ Click on the KEEP button

The KEEP button turns grey (meaning the information is no
longer stored in the Record Buffer) and a small ¢ appears to

the left of the percentage for track O1. This signifies some
change has been made to the track and has not yet been
saved to disk.

To Hear What Has Been Recorded:
¢ Click on the PLAY button

To Add Another Part:

¢ Click the PLAY button

e Play an additional part on your instrument in time with the music on
track 01

e As soon as you begin playing, the KEEP button is highlighted

e When you're finished, click on the STOP button
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You'll now need to put this part on a separate track.

To Save Overdubs:
e Select an empty track by clicking on its track number

08% You can tell a track is empty because the memory
' percentage shown for that track will be 00%

¢ Click on the KEEP button

The KEEP button greys and a little ¢ appears to the left of
the track percentage

¢ If you click the Play button once again, you'll hear both tracks 01 and 02

Bl:part 1 < o1 ¢

b @ :
o »02: part 2 ¢ e« BiZ i
8 03: ¢ 007 &
04: ® 00z &
85! o 087 =
6! @ 8087 |

You can keep building tracks this way until all the tracks are filled up.
Congratulations! You've just learned the basics of recording using EZ-Track
Plus.



2-10  EZ-TRACK PLUS USER MANUAL



CHAPTER 3
BAsic OPERATION

In This Chapter:

¢ A Tour Of EZ-Track Plus
e Tracks

¢ Recording

e File Management

Key Words:

Backup Files

Bounce

Buffer

MIDI Channel
Overdub
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A TOUR OF EZ-TRACK PLUS

Ihe Screen

The screen is divided into two main sections: the Track Display on the left
and the Control Display on the right. The menu options are available from
the drop-down menu bar across the top of the screen. All there are other
screens or boxes that you will see later, this is the main screen from which
you will do most of your work.

_Desk File Track Edit HIDI Options Safety
»01: 80% ‘

version B
J=128 B % sunc

£

60600.08 |<

g, oL e :
\ [19999.95 J¢

1999995 ]¢
(] thru (@]

2(=1 ] NN [« [xer]

Memory used [ ] 8%

DDDDDDDDDDDDDDDDD D DD

EZ-Track+ ST 01986 Hybrid Arts Inc
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|The Menu Bar |

The Menu Bar contains many of the functions within the program. To
access any Menu function, point the mouse at any menu name (for
example, Edit). The menu will drop down. Now move the mouse to the
desired function. Once the function inverts, click the left button once.

Load...

Import Track...
Save as... A e sons
| Updare 1 [protect Copy Track
 Delete,., (| Uppratect lUnnix Track
| Format Disk... | | Glue Section | | JUUCEC TR

Current Drive Belete | Velocity Adjust |
hubrisaiteh Erase Song

Quit

Entering Menu
v Shift + Enter

ot o 00 00 00000 200000 00 000 D0 200 A0 S0 200 0]

Meter/Metronone
Quantize Method v/ Deleting
Whole vs Region v Replacing

ave e o0 00 st 10t aov owe 200 400 300 00 00 00000 00 300 00|

Track Delays v/ Back Up Files

Send Mode Msg

v v e ane e 200 200 200 00 00 200 000 000 200 200 200 2|

Input Filters
Qutput Options

oo v oot 300 00 000 00000 400200 200 200 o0 o0t o0 2]
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{The Track Display |

1

| 01: chord groove Z
§ 202! solo lead
83: bass

B4 g
85: /
06! 5
07:

08:

29:

1a;

i1

12:

13:

14:

15:

i6:

17:

18:

19;

20;
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Track Pointer

Track Number

Track Name

Track Mute ON

Track Mute OFF

End Of Track Indicator

Track Activity Indicator

Track Changed Since Last Save

Track MIDI Channel Column (Output Assignment)
Track Protected

Percentage Of Memory Used By A Track

EEEEEEEEEE

p—
—

All information listed is separate for each track.

The picture to the left is an example of how the Track Display may look
during a session. It shows the following: MIDI information, track names,
mute status, etc.

The Track Activity indicators show how many notes are being played
simultaneously (per track). The chart below describes what each indicator
represents. If you see a percent sign, for example, then there are 5 notes
being played at that time, on that track.

Track Activity Indicators

Indicator: 1 @ # $§ % A~ & * ()
Notes: 1 2 3 4 5 6 7 8 9 10

A track playing more than 10 notes has a + Indicator
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[The Control Display |

2 : Me And My Arrow
version 8 | 04-01-88 02:35 p
d=96.8 A 2/4 ¢ Sync |/
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6 7

10 =

" - [y, OIS L 0]
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The information is explained from top to bottom, left to right:

Song Name

Version # Of The Curent Song

Date (MM-DD-YY) & Time Of Last Save
Tempo Setting

The Metronome

Displayed Time Signature (Optional)
Metronome Sound On/Off
Synchronization Type (Internal & MIDI)
Register/Section Mode Indicator (Register Mode shown)
Start Time

Punch-In Time

Punch-Out Time

End Time

Locate Enable/Disable (shown Disabled)
Punch Enable/Disable (shown Enabled)
Counter Reset Button

Counter

Global Transpose

MIDI channel NOT affected by Global Transpose
MIDI Thru ON/OFF

MIDI Thru To This MIDI Channel

STOP

PLAY

PAUSE

FF/REWIND

KEEP

Total Memory Used For Song

Note:
The Memory used bar and percentage indicate how much of the total song
memory available has been used. Editing operations require varying
amounts of free memory for temporary storage. Press Control Alternate
Shift N to get a readout of the amount of total song memory available; this
memory amount will vary depending on how much RAM you have in your
Atari ST, and what other programs (desk accessories, HybriSwitch, some
AUTO folder programs, etc.) are in memory when you run EZ-Track Plus.

37
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Program Design

Every effort has been made to make EZ-Track Plus an easy program to
operate. It is a very visual system; you place MIDI information on separate
tracks, each of which you can name, protect, mute and deal with in a wide
variety of ways. You have the equivalent of VU meters with graphic symbols
appearing to denote the presence or absence of notes. There are no pages to

flip through in order to view the key information you need to know; it's
always right in front of you, always tracking in real time.

Use The Mouse And/Or Key Commands

Commands are given either by pointing and clicking with a mouse, or by
using the computer keyboard with pre-programmed mnemonic keys
(meaning keyboard commands are linked as much as possible ‘to the first
letter of the function being used, eg. Mix uses the letter M). Using the
computer keyboard requires, with a few exceptions, that you press down
two keys at the same time, normally the Control Key and a letter. For
example, if you wanted to access the Copy tracks function you could press
the Control key and the letter C. Of course, you could just as easily select
Copy Track from the Edit menu.

Every basic function is available all the time. As you become more familiar
with the program, you may find yourself favoring one or the other methods
of control, either mouse or computer keyboard, but more than likely you'll
be using a combination of both. The software is designed to make it easy for
you to use, whether you are a brand new user or a seasoned expert.

Refer to Appendix K for a table of key command equivalents
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Non-Destructive Editi

Another design philosophy incorporated within EZ-Track Plus is that of
non-destructive editing. None of the editing you do to a track has to be
permanent. When you edit, you may save the edited version to any track. If
you feel confident with your edit, you can place the edited version over the
previous one. However, if you want to retain the original version, even if it's
just for safety's sake, select another track and put your altered data there.
This way, if you're unhappy with the changes, you always have the original
stored on another track.

As much as possible EZ-Track Plus protects your work from inadvertent
errors. You can protect individual tracks so that you cannot save new or
altered data to them. You can have the program warn you if you are about to
replace or erase a track. If you overwrite a song file on disk, EZ-Track Plus
will automatically make a backup copy of the previous file, if you so choose.

In short, great care has been made to ensure as much safety as is possible
to protect the work you'll be creating using EZ-Track Plus. The design
philosophy of Hybrid Arts is that of non-destructive editing, so you can feel
free to experiment as much as you like without worrying that your original
ideas will be erased.



3-10  EZ-TRACK PLUS USER MANUAL

TRACKS

There are 20 independent tracks available. When you record something,
you save it to a track. When you want to hear what you've recorded, turn
that track ON, and press PLAY. Tracks are the place where you organize
your work.

Track Selection
To the left of the track numbers you will see a small arrow; this is the track

selection indicator or pointer. Its function is solely to determine which
track is selected or about to be accessed.

To SELECT A Track:
¢ Click once in the area shown

To select Track 03
click in this area: \

»01: Bass 1 ¢ ! B 14%
02: Pian intro §# @ ¢ p05%
: 4 00%

Bridge Strings  © ! c@®p12%

The Track Pointer will move to that track.
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To SELECT A Track Using The Keyboard:

¢ Press the Up or Down arrows on the Atari ST keyboard.

¢ As you press the key, the pointer will go up or down one track at a time,
depending which directional arrow you press.

Press This Key On To Select This Track
The Computer Keyboard On The Screen
1 Track O1
0 Track 10
Shift 1 Track 11
Shift 0 Track 20
Note:

The numeric keys are those above the ST keyboard, not those on the
numerical keypad to the left of the ST keyboard.
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Each track can have a name containing up to 16 characters. This allows
you to organize your tracks depending on your preference and keep a visual
reference as to what is contained on each track.

To NAME A Track:
* Select the track you wish to Name
¢ Select Name from the Track menu OR press Control N

¢ Type in up to 16 characters (use Esc or Backspace if necessary)
¢ Click OK

Track 1 name: Trumpet SolnL___

Lok | [CCancel |}

The dialog box disappears and the track you selected now has a name.

To Change A Track NAME:

e Select the track you wish to Re-Name

¢ Select Name from the Track menu OR press Control N
The current name appears with the cursor at the right end

e Type in up to 16 characters (use Esc or Backspace if necessary)
¢ Click OK

Use Esc (Escape) to clear out the name. Use Backspace to erase one
character to the left of the cursor.

Note:
Track names can be used as memo pads for writing general notes about the
song, remembering patch settings, etc.
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Track Protection

You may protect individual tracks from changes or accidental erasure. This
feature is a software "write protect” which prevents you from writing over an
important track. You can edit a protected track as long as you save the
changes to an empty unprotected track.

To PROTECT A Track:
¢ Select the track you wish to Protect
» Select Protect from the Track menu OR press Control P

A p appears to the left of the track percentage indicating that the track is
now protected.

To UNPROTECT A Track:
* Select the Protected track you wish to Unprotect
¢ Select Unprotect from the Track menu OR press Control Shift P

The p disappears from the protected track, indicating it is now unprotected.

81: Protected ¢ < p0B%
»82: Unprotected ¢ < 00%

If a track is protected and you try to save something on it, you will see the
following warning (the edit will not be saved when you click OK and you
must re-do the edit and save it to a blank track):

@ Track 1 protected!
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Turning Tracks ON and OFF

Directly to the right of the track name is an arrow pointing up or down.
This arrow represents the mute function for the track; up means it is not
muted (ON) and will play back the information stored on the track, down
means the track is muted (OFF) and won't be heard. In addition, tracks can
be soloed (all tracks OFF except the one that is selected) and Bowed-Out (all
tracks are ON except the one that is selected).

Click These Mouse Select A Track,

To Do This Buttons On A Track's Then Press These
ON/OFF Arrows Atari ST Keyboard Keys

Mute A Track Click RIGHT Shift DOWN ARROW

Unmute A Track Click LEFT Shift UP ARROW

Solo A Track Click and Hold LEFT |Control UP ARROW

Then Click RIGHT

Bow-Out A Track Click and Hold RIGHT |Control DOWN ARROW
Then Click LEFT

Mute ALL Tracks Solo A Track Control Shift DOWN ARROW
Then Mute It

Unmute ALL Tracks |Bow-Out A Track Control Shift UP ARROW
Then Unmute It
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There is a function which erases all information on a track. When you
attempt to do this a dialog box will appear, verifying your intention to delete
the track, as this action will destroy anything you have on the track and
you may NOT reverse the process. Be sure that's what you really want to do
before erasing the data on the track.

To DELETE A Track:

¢ Select the track you wish to Delete

¢ Select Delete from the Track menu

e If Deleting is checked under the Safety menu, a dialog box will appear
asking you to verify this deletion. Click OK.

¢ The track percentage will change to 00%

Note:
If the track you selected is already empty, the Delete function will be disabled
and you won't be able to use it.

EZ-Track Plus is an interactive program and allows you to make choices
based on functions available at the time. For example, if there isn't any data
on a track, you won't be able to delete it.

To DELETE A Track Using The ST Keyboard:

¢ Select the track you wish to affect

e Press Control Shift D

* A dialog box will appear verifying your decision to erase the track
¢ Click Delete OR press Return

v Delete track 1 ?

|Delete| Icancell
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Assigning MIDI Channel

You can assign any one of the 16 MIDI channels to any track.

To ASSIGN A MIDI Channel:

¢ Point to the Track MIDI Channel Column

¢ Click with the RIGHT button to increase the MIDI channel number
¢ Click with the LEFT button to decrease it

»81: bass 1) 81«
02: melody & chords ¢ Na1y
B83: accompaniment ¢ a1%

Click once with the Right button

»01: bass ) ER B8ix
02: melody & chords ¢ a1y
83: accompaniment ¢ iz

To ASSIGN A MIDI Channel From The ST Keyboard:

¢ Select a track

¢ Press Shift ] to increase its MIDI channel number

Press Shift [ to decrease it

¢ Press Control 1 through Control O to assign MIDI channels 1 though 10

¢ Press Control Shift 1 through Control Shift 6 to assign MIDI channels 11
through 16

¢ Press Control Shift O to reset the MIDI channel assignment to its original
unassigned status

For example, if you press Control 4, then MIDI channel 4 (shown as a TV
GUIDE style channel 4 indicator) is assigned to that track.

If a MIDI channel is not assigned, all channel data on that track will play
back as it was recorded. For example, if two tracks with two different MIDI
channels are mixed, and the destination track has no MIDI channel
assigned, that track will play back both channels correctly.
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RECORDING

No matter which method you'll be using to arrange your music, you'll still
need a good grasp of the recording fundamentals built into EZ-Track Plus.
Although the program allows you to sequence music in many different
ways, the basic recording method is the same. EZ-Track Plus has been laid
out in a similar fashion to a multi-track tape recorder using analogous
controls that most musicians are already familiar with. This section covers
the operation of these controls.

The Record Buffer

It is important to understand how EZ-Track Plus is recording. As soon as
you press PLAY, it will record whatever you play on your instrument. When
you play a key, change a patch, or use the Pitch or Mod wheels, EZ-Track
Plus stores that MIDI information in its Record Buffer.

The MIDI information remains in the Record Buffer unless you do one of the
following:

click on the KEEP button Stores the data from the buffer to a selected
track
click on the PLAY button Places EZ-Track Plus in active record mode

once again, wiping the buffer out and
readying it to recieve new MIDI data

click on the Counter Reset Also wipes out the buffer

click on FF/REWIND Also wipes out the buffer

The menu operations which replace' or delete tracks (and
Meter/Metronome) also clear the Record Buffer.
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You store music and other information on tracks AFTER THE FACT of
performing or creating it, not before as in conventional recording
techniques. This also means you can always overdub tracks without
worrying about assigning a track or recording over music you want to keep.

WHENEVER EZ-TRACK PLUS IS IN PLAY, IT IS ALWAYS RECORDING. In
fact, EZ-Track Plus is always recording even when it's in PAUSE.

It records exactly what you play when you play it. Quantization and all
other forms of music processing are done AFTER the information has been
stored to a track, not during recording.

Record Controls

The Recording Controls are shown below:

> | —[ seens.88 |¢
Locate/Punch Times > @j’ ¢

g o[ 19999.95 |¢
> | [ 19999.95 ]¢
Master Counter

Recordin
Control§ (=] [>] NN [« [xzzr]

7
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In order of sequence these buttons represent the following functions:

STOP

[m]

PLAY/RECORD

[ ]

PAUSE

This stops EZ-Track Plus and also turns off any
MIDI Notes at the point where it was stopped.
The equivalent key command is the Return key.

Note:

When you press STOP, PAUSE becomes
highlighted. You can continue playing from
where you stop by clicking PAUSE or pressing the
Tab key.

This button starts EZ-Track Plus, playing from
the start (either the beginning of the track or the
Start Time if one has been set and Locate
activated), and automatically places it in record
mode. Pressing the space bar is the equivalent
key command.

This will cause EZ-Track Plus to pause during
playback, and any MIDI notes currently ON will
remain ON. To continue playing from the point
paused, click PAUSE again. Press the Tab key as
an alternate way to pause.

Note:

You may continue playing from wherever you
pause by clicking PAUSE or pressing the Tab key
a second time.



320 EZ-TRACK PLUS USER MANUAL

FORWARD/REWIND

[«O»]

KEEP

COUNTER

This operates like a conventional recorder, rolling
the location of the music forward or backward.

FORWARD ¢ Point at the FF/REWIND icon
¢ Click and hold the Right button
e EZ-Track Plus keeps rolling forward
until you release the mouse button.
¢ Click PAUSE to continue if you're in
PAUSE mode

REWIND e Point at the FF/REWIND icon
¢ Click and hold the Left button
e EZ-Track Plus keeps rewinding
until you release the mouse button.
¢ Click PAUSE to continue if you're in
PAUSE mode

This KEEPs the recorded music that currently
exists in the Record Buffer of the computer. Click
on this box to perform the transfer FROM the
Record Buffer TO the selected track.

BEFORE clicking on the Keep icon ALWAYS
SELECT THE TRACK YOU ARE GOING TO KEEP
YOUR MUSIC TO.

The keyboard equivalent is pressing Shift Enter
(numeric keypad). If Shift+Enter is unchecked
under the Safety menu, pressing just Enter will
KEEP the Recorded information.

Directly above these controls is a counter.
Instead of measuring feet of tape as a
conventional recorder does, this one counts
beats/ticks (or measures/beats/ticks) of time in
increments of 96 ticks per beat.

To RESET The Counter:

e Click on the Reset button to the left of the
Counter

OR

¢ Press Control Space Bar



CHAPTER 3 o BASIC OPERATION  3-21

Auto-locating

When dealing with analog tape recorders, there is always a significant lag
between the time you Stop the tape deck, rewind it to the beginning (or an
earlier point on tape), and press the Play button to listen to what's recorded.
Not so with EZ-Track Plus. Auto-locating is a method of instantaneous
location to any moment of time. (There is a limit: 20,000 beats of music, or
5,000 bars of 4/4 time, but not many compostions will go that long).

—EG’ The top number is the Start Time. The bottom number
88609, 80 is the End Time. Directly to the left of these times,

there is a connecting line. By pointing to anywhere on
the connecting line and clicking, the Start and End
times are activated (you'll see the two arrows to the

—HJ| 19999.95 |<¢ right of these counters "light up" to indicate they are

active).

To Set The Start Time:

¢ Point with the mouse at the numbers within the Start Time
¢ Use the RIGHT button to increment any digit

¢ Use the LEFT button to decrement any digit

¢ Change the Start Time to any beat/tick

— For example, if you wanted to start at beat
JEE), 30, point to the Start Time and click on the
second number left of the decimal with the

—EI 86030.08 |¢ RIGHT button until it reads 00030.00.
ma) 00804.88 |< With precise pointing, you can increment
« 19999.95 (¢ and decrement by 10's, 100's, 1,000's or

10,000's or by individual ticks as well. Point
—fl| 19999.95 |¢ to the column you wish to increase or

decrease and click the appropriate mouse
00008,00 AThey

Once you have set the Start Time AND activated Auto-Locate, the Start Time
becomes the point at which EZ-Track Plus starts playing. There is an
extremely slight lag between the time you press PLAY and the time EZ-
Track Plus locates to the beat you've selected, whether the beat is 20 or 220
or 2,020.
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éﬁk &

88838.08 —| 88036.088
Enable E 880008,00 Sequence E | 80000.88 |

Auto-Locat Starts F:
uto-Locate [To993.95 Jo| Swarts From [19999.95 |

[ 19999.95 |
Em (&) [90m35.50 |

= O] NN (=] N

You can also set a Start Time "on the fly". As EZ-Track Plus operati as are
all done in real time, if you point to the small arrow to the right of the Start
Time and click as EZ-Track Plus is running, whatever time is displayed in
the Counter will be automatically stored in the Start Time. By clicking the
LEFT button, it will be the exact time to 96 ticks as displayed in the Counter;
if you click the RIGHT button it will be rounded off to the nearest beat.

Every action described above is also applicable to the End Time. Although
this Time is usually left at the highest possible number (it defaults to
19999.95), by setting it to another number greater than the Start Time, you
can play back a given portion of a piece. In other words, the End Time
signals the computer to Stop playing, just as the Start Time tells it where to
begin playing.

To deactivate the auto-locate feature, click on either of the two auto-locate
icons or the connecting line to the left of the Start/End Times. The arrows to
the right of the Times will become empty, signifying that the auto-locate
function is disabled. Thus when you start EZ-Track Plus again it will begin
at 00000.00.

Auto-Locate Functions:

H—#0000.00

(Clle Arrows to Set

|

Time:
: W/Left Button for
Enable/ ' Exact Time,
Disable —— W/Right Rounded
Bar to Beat

: B»0000.00 O,CounTer
End Time /@ 0000.00

Reset/ —
Cue
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To ENABLE AUTO-LOCATE:
» Click on the Enable/...saole Bar (or Press * on the ST numeric keypad)

To DISABLE AUTO-LOCATE:
¢ Click on the Enable/Disable Bar again (or Press * a second time)

TO SET START or END TIMES:
e Poiut to the numeric column you wish to adjust
¢ TJse the RIGHT button to increment the number
e Use the LEFT to decrement .

TO SET START or END TIMES "ON THE FLY":

¢ Click on PLAY to start the sequencer

¢ Point to the arrow to the right of the counters

¢ Click LEFT to enter the exact time as it reads on the Counter

e lick RIGHT to enter the Counter number rounded off to the nearest beat

You can "Cue up" to the Start Time without automatically beginning to play.
Set the Start Time and press Control SPACE BAR, or click on the Counter
Reset button. EZ-Track Plus will locate to that point (you'll see the master
counter change to that time) but won't start playing until you click the
PAUSE icon, or the TAB key.

Keep in mind, though, if you have any Note On events that fall on that locate
point, they will trigger and keep playing until you start the sequencer up.
It's usually a good idea then, if you're cueing up in this way, to select the
auto-locate time 1 tick before the beat so you don't have any notes sounding.

When the Start Time is active and the Counter is Reset, the Counter will
auto-locate to the Start Time. In other words, if the AUTO-LOCATE function
is ENABLED, then whatever time is set as the Start Time also becomes the
reset value for the Counter.
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QOverdubs

This is a fairly simple procedure, but is mentioned here as it is an important
factor of analog recording, and there should be no confusion as to how this
is achieved using EZ-Track Plus.

EZ-Track Plus is always in Record mode, but also plays back every track
(provided, of course, they are not muted) whenever it is put into Play. This
means that whenever you click on the PLAY/RECORD button, you will
always hear your previously recorded tracks. As you are also in Record
mode while you're hearing these tracks, this also means you can OVERDUB
whenever you want to simply by playing the next part as EZ-Track Plus is
running.

As soon as you've completed the overdubbed part to your satisfaction, select
a track to assign it to and click on the KEEP button to store it on a track.

You can continue overdubbing as much as you want, simply storing each
successive overdub to another track each time you've finished.

Punch-I h-

Often, you'll find a need to correct a section in the middle of a track, either
erasing it fully or replacing notes. EZ-Track Plus allows you to set two
specific times in a track between which the sequencer will automatically re-
record and replace the MIDI information with new data.

Punching in and out of a track is fully automated to
l: | 86000.88 |¢ allow you to concentrate on your performance rather
than the Punch. EZ-Track Plus allows you to set your
1”” 35 In and Out punch points in advance, start the recorder
running, and put you in and take you out of record at

just the right moments.
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Pictured are the two times related to Punching. The

ﬂg 00018.18 |¢ top is the Punch-In Time, and the bottom is the

Q' Punch-Out Time. By clicking on the Punching Glove,

1| 80829.35 |4 punch "impact marks" indicate the Punch times are
activated.

Select a track to Punch. You'll need to activate Punch BEFORE you choose a
track. When you select a track to Punch, that track will become reverse
highlighted. You can only Punch on one track at a time, so you will always
have only one track reverse highlighted.

B1: Punch This TrackjE 1 WA
»02: Save It Here 1) 087
83 o [} ¥
04: ) 08%
To Set The Punch-In Time:

e Point the mouse at the numbers within the Punch-In Time
e Use the RIGHT button to increment a digit

e Use the LEFT button to decrement a digit

¢ Change the Punch-In Time to any beat/tick

If you want to Punch-In at beat 40, click on the 10's column digit with the
RIGHT button until it reads 00040.00 If you are precise in your pointing,
you can increment/decrement by 10's, 100's, 1,000's or 10,000's or by
individual ticks as well. Point to the column you wish to increase or decrease
and click the appropriate mouse button.

Punch-Out times are set the exact same way as Punch-In Times. The
Punch-Out Time must be greater than the Punch-In Time, but if you
inadvertently make it smaller, when EZ-Track Plus begins playing it will
change this to the same time as the Punch-In time. Although nothing will
occur, you won't lose any track information either. If this happens, reset
the Punch-Out Time and start Play again.
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You can also insert a timing location into the Punch counters "on the fly", as
you do with the Auto-Locate function. As EZ-Track Plus operations are all
done in real time, if you point to the small arrow to the right of the either
Punch Time and click the mouse button as EZ-Track Plus is running,
whatever time is displayed in the Counter will be automatically stored in the
Punch Time. By pressing with the LEFT mouse button, it will be the exact
time to 96 ticks; if you press with the RIGHT button it will be rounded off to
the nearest beat. This makes marking punch points very easy, as you can
note the In and Out locations while you're listening to the track.

EZ-Track Plus also automatically turns Notes Off when it punches in the
middle of a sustained note, so you don't have to worry about finding the
precise Out point just after a note is ended.

To deactivate Punch, point the mouse at the Punching Glove and click. The
arrows to the right of the counters will become empty and the glove will
return to normal, signifying that Punch is disabled.

Because Punching is a recording process, the information is stored in the
Record Buffer and requires that you assign it to a track when you're
finished. This means that your original track is always safe from any
punches you may attempt, providing that you place the music you've just
punched to another track location. This is another example of non-
destructive editing: you can run the same punch over and over again
without fear of losing your original music, and when you're satisfied, store it
on another track.

Note:
While Punch is enabled, you can only click to the left of the track number
when Selecting a Track for saving.
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To Enable Punch-In/PUNCH-OUT:
¢ Click on the Punching Glove (or press / in the upper right corner of the
numeric keypad)

To Disable PUNCH-IN/PUNCH-OUT:
¢ Click on the Active Punching Glove (or press / a second time)

To Set PUNCH-IN and/or PUNCH-OUT TIMES On The Fly:

¢ Click on PLAY to start the sequencer

¢ Point to the arrow to the right of the counters

¢ Click the LEFT mouse button to enter the exact Counter time

¢ Click the RIGHT button to enter the Counter time rounded to the nearest
beat

To Punch A Track:

¢ Make sure you can see the Cash Register icon before you begin

e Set the Punch-In Time

¢ Set the Punch-Out Time

¢ Enable Punch Mode

e Optionally set the Start and End Auto-Locate Times
and Enable Auto-Locate

e Click in the Track Name area of the track you want to punch
This becomes the Punch Source Track
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s Click on PLAY

e The KEEP button highlights and the sequence starts playing

¢ As the sequence plays, the information from the Punch Source Track is
copied into the KEEP Buffer

e Any information in the KEEP Buffer that was previously on the Punch
Source Track between the Punch-In and Punch-Out Times is erased. If
anything is played between these two times, it is recorded in real time as it
is played.

e When you are finished, click on STOP

¢ Click to the left of the track number to select a Punch Destination Track

groove B?.
82: solo lead 1) 81z &

©  B3: bass ) (1 LIV
|| *04: ] 007 &
 x05: o eex |
® 06 ] 807 &

87: ] 08% |

¢ If you select the same track as the track you Punched on, the information
previously on that track will be replaced with the new information.

¢ If you selected a different track, make sure to tum off the Punch Source
Track to hear the new edit

¢ Click on KEEP to save the information in the KEEP Buffer

Notes For Punch-In/Punch-Out

¢ To be able to KEEP the punched result, you must either wait for the
counter to pass the Punch-Out Time, or press STOP (or PAUSE).

e After you KEEP a punched result, the Punch feature is automatically
deactivated. If you want to do another punch right away, you will need
to re-enable Punch.

* Once you PLAY or Locate, you cannot select a different track to Punch-
In on, unless you deactivate and reactivate Punch (by clicking twice on
the Punching Glove).

* Punch can also be used to erase a section of a track, without recording
any new information; the only restriction is that the Punch-In Time
must be set past the zero Counter setting (ie., 00000.01 or greater).
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Iempo & Metronome

Directly below the version number you'll see a quarter note, an equal sign
and a number, representing Beats Per Minute. Tempo adjustment is fairly
easy: by pointing at the number itself and pressing the RIGHT or LEFT
mouse buttons, you can increment or decrement the Tempo in small steps.
By pointing at the quarter note and pressing the RIGHT or LEFT mouse
buttons, you can increment or decrement the Tempo by a wider margin.

version 0

J=128 (4

The Metronome icon is directly to the right of the Tempo indicators. A
speaker icon exists to control the playback of a click: if you want to toggle it
on or off, simply point at it with the mouse and click.

A

Metronome Click On: :(]’

N

Metronome Click Off: ‘(]
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To Adjust The Tempo:

For Coarse Adjustment ¢ Click on the Quarter Note
OR
e Press Shift > or Shift <

For Fine Adjustment * Click on the Tempo Value
OR
*Press > or <

e To Increase the Tempo: Click the RIGHT button OR Press the < key
e To Decrease the Tempo: Click the LEFT button OR Press the > key

Setting The Tempo: Slower Faster
_ S F
0
Click here _T t Click here
for coarse adjustment for fine adjustment A

To Toggle The Metronome ON/OFF:
* Click on the speaker icon to the right of the metronome
OR

¢ Press ' (apostrophe) on the ST keyboard
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step Recording
Another method of recording called STEP Recording is available. This
means you record your music in non-real-time. You control the

advancement of the beat or fractions of a beat directly. One quarter-note
beat is equal to 96 ticks (the numbers to the right of the decimal point).

Step Recording is tedious work, but useful in a variety of applications (tight
drum rolls for instance). As EZ-Track Plus is alway in record mode when
playing, the master Counter can also be used to Step through a recording.

Single Step Modes:

to advance by 1 beat ( J to advance by 16th Notes

Click here _T t Click here with LEFT button
to reset to zero to advance by ticks

Click here Click here with RIGHT button
IR

N

You can also control Counter advancement from the ST keyboard:
The / key advances by 24 ticks (16th notes)

Control Tab advances by individual ticks

Shift Tab advances beat by beat
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As you advance the counter, play a note and hold it down as long as your
music dictates. If you're going to play a quarter note and you're advancing
the counter by 16th notes, you'll have to hold the instrument's key down for
4 movements of the counter (four 16ths = one Quarter note). This gives you
very precise control over what you're entering, although its usefulness is
limited.

Table Of Step-Entry Note Value Equivalents

Note, JJ I 22035

4 2 1,
Advance
Clock Beats
By This '
Amount

\96 64 48 32 24 16 12 08/
Ticks

Note:

You will hear music on tracks play as you slowly advance through the piece.
By noting when the notes occur you can quickly and precisely Punch In and
Out to make corrections.
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FILE MANAGEMENT

Song files are stored on the standard 3.5" disks your Atari ST uses. Saving
and recalling songs and even portions of song files are relatively simple
operations.

Formattin

When a disk is fresh out of a box, it needs to be formatted. Different
computer manufacturers use different operating systems, so disks
formatted on one brand of computer won't be able to be used on another
type.

Before saving song files, you'll need to format a disk. If you already have a
formatted disk, there's no need to reformat it; especially since when you
format, it erases all the information you have stored on a disk.

To FORMAT A Disk (From Within EZ-Track Plus):

* Select Format Disk from the File menu

¢ A dialog box appears, warning you that formatting will erase all the
information on a disk and verifying you want to do this

¢ Click on the YES box to continue.

Formatting will ERASE all the
information on the disk. Are
you SURE you want to do this?

| Yes | |Cancell
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e Place a blank 3.5" disk in the drive

¢ If you have two drives, choose which one you use

* Another dialog box appears, asking you which drive and format (single
sided, which gives you approximately 360K worth of disk space or double
sided, bringing available disk space to 720K) you care to use

¢ Choices are inverse and can be changed by clicking on the options

¢ Once you're ready to format the disk, click on the Format box.

Format Disk:

n As the disk formats you'll see the drive
light come on and hear a whirring

LIRS | Double-Sided sound. This will continue until disk

formatting is complete.

[ Format | | Cancel |

I iv

If you have more than one drive or a RAM disk, EZ-Track Plus can store
song files to one of the additional drives. If you have a hard disk, it can be
divided up into several partitions (C through P depending on the size of your
disk).

To Set CURRENT DRIVE:

¢ Select Current Drive from the File menu

* The dialog box that appears shows which drive is the Current Drive
* Type in the letter of the new desired drive (B, C, etc.)

¢ Click OK or press Return

Your files will now be stored to or recalled from the new current drive.

Current disk drive: |

| ok | | Cancel |
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saving Song Fil

All the MIDI information you have recorded along with many option
settings you've altered are stored in the song file. This means Tempo
settings, MIDI channel assignments and any other information particular
to the setup of the music you're saving will be included in the saved file.
(Sync Type, Auto-Locate, Punch, Input Filters, Locate Method, Quantize
Method, and Whole vs Region settings are not saved.)

To SAVE A Song File:

¢ Seclect Save As from the File menu

¢ A window will appear, prompting you to type in a name for the file you
want to save. This can be any 8 character name, providing you follow the
normal file naming rules contained in your Atari Users manual. The .SNG
extension will automatically be added to the file. DON'T TYPE ANYTHING
AS AN EXTENSION (3 CHARACTERS AFTER THE PERIOD) UNLESS YOU
FULLY UNDERSTAND HOW TO USE THE ITEM SELECTOR BOX.

e When you're ready to save it, click OK or press Return

Note:

When you save a song a second time using the Save As option, you'll notice
the previous name is automatically entered in the sclection box {rom the last
time you saved the file. This makes it casy if you want to save it under the
same name. If you want to save the song as a different filename, press
Backspace or ESC (Escape) first to clear the previous name. Practice typing
a different name using a test song to sec what happens. Undecrstanding
this process can save frustation later knowing the file is saved correctly.

ITEM SELECTOR

Directory:
fi:\¥%,SHD

Selection:
HEWSONG .SHE' < Enter your song file
name under the word

MOOHJIG .SHG
SIMPSAMP . SHG Selection.

DO NOT ENTER YOUR
_— SONG FILE NAME

0K UNDER THE DIRECTORY
- - LINE; THIS IS RESERVED

FOR OTIIER ITEMS.
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Update

Once you've saved a file, there is a shortcut way to update it. This speeds up
the process of regularly saving your work as you are writing and developing
it, a good idea in every case. The Update _function only becomes available
after you've saved a file until you Load a new file or Erase the Song. This is
set up so you can't inadvertently alter or save to the wrong file.

When working on important material (usually most of the time), it is
recommended that you Update your Song every 10 minutes or so. A single
power failure could ruin your entire session!

To UPDATE A Song File:
* Select Update from the File menu OR press Alternate U

Your work will automatically be updated in the same file, without you having
to go through the process of naming it or clicking on its already existent
name. Updating is purely a shortcut that saves a few mouse moves for you,
and lets you easily update the information in a previously saved file.

Loadin Fil

You can recall any .SNG file from disk in much the same way as you save
them.

To LOAD A Song File:

* Select Load from the File menu

¢ A dialog box will appear, warning you that when you load in a new song
file, you will be erasing the song now in memory

Loading a new song file will
@ erase the song now in memory.

| ok | |Cancell

¢ If you want to save the current file to disk, click Cancel and save it
¢ Otherwise, click OK or press Return to continue
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An Item Selector box appears with a menu of the .SNG files on the disk that
you can load.

ITEM SELECTOR

Directory:
A:\%,SHG

8 AUTO .
5SONGS . SHG
MENDPRLL . SHG
MOONJIG ,SHGR
QUESTION. SHG
SIMPSAMP . SHG

Selection:

MENDPRLL, SHG|

Click on the song name you
want to load

The name will be transferred
to the Selection line

If necessary, scroll through
the window by clicking on
the arrows to the right of the
small window

Once you have selected the
file you want to load, click OK
The disk drive will whirr for a
few seconds and the song
file will be loaded in memory.

Note:

Song files saved with the original EZ-Track can be loaded into EZ-Track Plus
and vice versa. Song files created with EZ-Track Plus can be loaded into any
of the MidiTrack ST Series of MIDI Recorders (SyncTrack, SmpteTrack).
Songs files created with MidiTrack ST can be loaded into EZ-Track Plus if
they don't have special track types (Chains, Tempo, Meter, etc.) and only
use the first 20 tracks.

Song contains track types
(such as chain, tempo, meter,
or shadow) not compatible
with EZ-Track Plus. You may
want to try Import Track...
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Deleting Fil

You can delete any file you want from a disk, including files with other than
an .SNG extension. A good example of when to use this is if you don't have
any blank disks handy, and the disk you have been using to save your work
is now full. By deleting old versions of songs, backup files (with an extension
of .SBK), or unneeded files, you can create room on the current disk for

saving your song file.

To DELETE A File:

¢ Select Delete from the File menu
* A window appears with a menu of all files on the current disk
e Click on the file you want to delete

ITEM SELECTOR

Directory:
ANk, X

MY_BEST .SNG
MY_FIRST,SNG
MY_WORST., SHG

| Selection:
HY_WORST . SHG|

e The name transfers to the
Selection line

¢ If necessary, scroll through
the window by clicking on
the arrows to the right of
the small window

¢ Select the file you want to
delete

e Click OK

e A warning dialog box will
appear, verifying your
desire to delete the selected
file

e If you are satisfied with
your selection, click Delete

e The disk drive will whirr for
a few seconds and the
selected file will be
permanently deleted from
the disk

v Delete file: MY_WORST.SNG ?

|Delete| IEancell
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In This Chapter:
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Copy Track
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Unmix Track
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Key Words:
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SELECTING TRACKS TO EDIT

Most of the Edit Menu functions work the same way. That is, they all need
some sort of initial track to perform the edit on, then a destination track or
where the information will be stored needs to be selected. This function of
selecting tracks is done when the following two prompt boxes are displayed
(the boxes for Copy Track are used as an example):

Click with the LEFT button to select the original track:

1: Use LEFT
button to!

Select track T Mm§é§ai% T
to COPY destinatine tragk

Use UNDO key to CANCEL

Click with the RIGHT button to select the destination track:

1: Use LEFT 2} Use RIGHT
button to: - button to:

'Select track Select
to COPY destination track

° Use UNDO keu to CRNCEL

When you see these prompts, moving the mouse up and down moves the
Track Pointer (it scrolls the track display if you try to move beyond the

displayed range of tracks). Moving the mouse left and right while in this
mode has no effect.

Tip
Whenever the right half of this prompt is greyed out, the
RIGHT button (as well as the Undo key) will CANCEL the edit .
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To select the initial track, Click with the LEFT button. To select the
DESTINATION Track, click with the RIGHT button. The following table
shows all of the functions that use this type of dialog box request:

Function Found Here Select Track To...

File Menu IMPOTt rreeccrrirscnnnes Selecting this function first
asks you to load a previously
recorded song to load
temporarily into memory.
This will not erase the song
currently in memory. Pick a
track to import then select
which track on the current
song to save it on.

Edit Menu 670 5, Pick one track to copy to
another.
Mix Pick up to 20 different

tracks to mix together and
save to 1 track.

UNINEX crorrrrnsnseeseseressinsans Pick a track to extract
information and save the
edit to another.

Quantize ... Pick a track to time adjust
and save the edit to another.

TranSpOSE ..o Pick a track to transpose
and save the edit to another.

Adjust Velocity ........... Pick a track to adjust its
velocity and save the edit to
another.

Note:
Anytime any one of the above prompt boxes are displayed, you can UNDO
the function by pressing the UNDO key. This is a good safety precaution.
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Using The ST Keyboard

All of the functions described above can also be accessed using the Atari ST
keyboard. Use the proper key command to initiate the function, then use
the following keys to move around and select tracks.

To... Press This Key:

Move Up 1 track UP ARROW

Move Down 1 track DOWN ARROW

Move to a specific track 1 through O, Shift 1 through Shift 0
Select a track Insert

(same as LEFT button)

Select a destination track Clr Home
(same as RIGHT button)

Press numeric Keys (1 - 0) to select tracks

Loft 7 D\ N

) e own  Right
Shift Keys Arrow  Amow Ar?ow
Key Key Key

I oL

Computer Numeric
Keyboard Keys Keypad
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EDITING FEATURES

In addition to standard recording techniques as decribed in the previous
sections, there are many methods of working with and manipulating music
once you've got it assigned to tracks. Because all of the music you've
recorded is stored within the computer as a series of numbers, the
rearrangement or correction of your performance contains possibilities far
beyond those offered by an analog multi-track system.

Music processing is similar in features to those that are available on word
processors, but oriented and expanded for music production. For example,
cutting and pasting paragraphs or sentences are common features on word
processors; in a similar fashion, EZ-Track Plus allows you to cut sections of
music and paste them elsewhere.

Quantizati

Quantization takes the timing of your performance and distributes the note
placement evenly across the track, based on a numeric value. The computer
has recorded your original performance to a timing accuracy of 96 ticks per
beat.

Not all of your notes will hit exactly on the beat; some will be a tick or two
before or after the beat, some will be right on. When you quantize a track, the
computer will automatically correct the timing to the nearest 16th note, or
8th or whatever you tell it. When you listen back, the performance sounds in
perfect time.

Quantize Evens Out Your Playing:
1., 2.3,

As Played:

Quantized:
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It is important to select the right quantization factor. If you played a phrase
with lots of 16th notes and you asked the computer to correct the timing to
the nearest quarter note, you're going to get several 16th notes rounded off
to a quarter note, playing one on top of the other. This works in reverse as
well: choose too high of a resolution factor and the notes may be shifted to
the wrong beat or fraction within the beat, playing noticeably late or early.

Because there are 20 tracks, there is plenty of room to experiment. Saving
the Quantized result to a separate track is a good way to test it without
destroying the original track. If the edit isn't quite right, you can always re-
quantize the original track.

To QUANTIZE A Track:
¢ Select Quantize Track from the Edit menu
¢ A dialog box prompts you to select the Quantize value

The dialog box has the 9 most-common note values to choose from:

OUANTIZE notes

to nearest: J J‘ f j

| 0ther |
ICancell J

— )

s w)
5w
4Srhw)

You are not bound to just these 9 values, they are just the most common. If
you want to quantize to another value, click the box marked Other. You now
have the option of entering your own resolution for any beat value between a
half note and a 192nd note.

Set QUANTIZE resolution to (2..192 ticks): 824

[ oK | [ CCancel |
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» Select the track you wish to QUANTIZE with the LEFT button
* The track selected will reverse highlight

[51; Quantize This . D17

&
i #82: Save It Here ¢ <« 004
| 03: ¢ 00z
B4: @ ge% |

e Select a DESTINATION track
e Click the RIGHT button to save the editing

The track you quantized is now placed on the new track. If you chose a track
other than the original, you still have the first, unquantized version
available.

You can QUANTIZE a track back to itself, but the orginal will be erased if you
do this.

To QUANTIZE A TRACK From The ST Keyboard:
¢ Press Control Q. This will bring you to the initial dialog box

This table is used when you select Other, to equate various note values to
numbers of ticks:

Quantize Note Value Equivalents
2 . % % %
I R I I
J92 96 64 48 32 24 16 12 08,
Ticks
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I ing Individual Track

You can transpose the information on one track (up or down) in a range of
one half-step to multi-octave jumps. This function actually changes the
note information and saves it at the new value. (Global Transposing does
not change the note information on each track; it just adjusts the values as
they are sent out -- See Global Transpose, Chapter 6.)

To TRANSPOSE A Track:
» Select Transpose Track from the Edit menu
* A dialog box prompts you to select the amount and direction to transpose:

Transpose # B octaves, 8 half-steps

¢ Click on the # (or b) to select up (or down) transpose

¢ Click on the digits to select the amount to transpose by
¢ Click the RIGHT button to increase

¢ Click the LEFT button to decrease

e Click OK to continue
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¢ Select the track you wish to TRANSPOSE with the LEFT button
e The track selected will reverse highlight

M01: Transpose This
4 #02: Save It Here -
§ 03: & e« pox @
04: @ 007 §

e Select a DESTINATION track
¢ Click the RIGHT button to save the editing

49

The track you transposed is now placed on the new track. If you chose a
track other than the original, you still have the first, untransposed version

available.

You can TRANSPOSE a track back to itself, but the orginal will be erased if

you do this.

To TRANSPOSE A TRACK From The ST Keyboard:
* Press Control T. This will bring you to the initial dialog box.

1: Use LEFT 2: Use RIGHT
button. to! button to:

Select track Select
to TRANSPOSE destination track

Use UNDO key to CANCEL
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Whole vs Region P .

If you've ever played a passage with 8th note triplets, 16th notes, 16th note
triplets and assorted other rhythms over the space of 8 bars, then you may
have some trouble selecting a quantization factor that will correctly adjust
each value. Or if you wanted to transpose 16 bars of a bridge because it
works better a step and a half higher, but the phrase is in the middle of a
track, what do you do?

EZ-Track Plus allows you to selectively apply music processing techniques
to your music, so that you can define a Region to be affected, leaving the rest
of the track unaltered. WHOLE vs REGION is an option that can be toggled
ON and OFF so that you are prompted to select one or the other just prior to
processing a track.

To Activate The WHOLE vs REGION Option:

* Select Whole vs Region from the Options menu

¢ Ask Which will prompt you asking whether the edit will affect the Whole
Track or just the defined Region

e Selecting Assume Whole affects the entire track ONLY (no prompt)

Ask 'Hhole or Region' for These functions Quantize Track
every edit such as Quantize are definable by Trans.pose '.I‘rack
or Transpose} or always a REGION: Velocity Adjust*

assume the Whole track is
to be edited?

|_Ask which | |Hssune Nhnle| *See Chapter 5
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To Define A REGION:

¢ Set the Start and End Times

¢ Adjust the Start Time to the beat where you want to begin processing
¢ Set the End Time where you want it to cease

To Preview REGION Time Settings:
e Activate the Auto-Locate function
¢ Click on PLAY

Affect the MHOLE track, To Use Region Processing:

or only the REGION e When the Whole/Region dialog box
between the register's appears, click Region to affect ONLY the
start and end times? region between the Start and End Times

 If you want to affect the entire track, click
Whole when prompted.

| WKhole | IRegionI

Notes For Region Time Settings

e Quantize values and the Region time settings are interdependent. If
you try to Quantize to quarter notes but the Region is defined from 4.35
to 8.67, you may not get the desired results because the Region is not
defined exactly on quarter-note boundaries.

e Transpose affects ONLY notes that start (Note On) within the Region.
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TRACK MANAGEMENT

EZ-Track Plus allows some very sophisticated track adjustments to offer
even greater flexibility in arranging your music.

in k

There may be times when you need to copy all of the information from one
track to another. You may want to copy a track: to set different track delays
on the copied tracks for creating an echo effect; to set each copied track to a
different MIDI channel for creating a fuller sound using multiple
instruments; or to reorganize tracks so they appear in a different order.

To COPY A Track:

¢ Select Copy Track from the Edit menu

¢ Select the track you wish to COPY with the LEFT button
¢ The track selected will reverse highlight

Bi: Original Track ¢ ]
»82: Copy To Here & < BO8%
a3: & < 007
04 ) 80%

e Select an empty track
e Click the RIGHT button to save the copy

The track you selected is now a copy of the original track.

To COPY A TRACK From The ST Keyboard:
e Press Control C. This will bring you to the initial prompt box.
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Mixing (B i T

In multi-track situations, you may often find yourself wanting to mix
several tracks together to better organize your music. Unfortunately, in the
analog world, each time you combine tracks (bounce down), your sound
quality deteriorates.

Thankfully, when you mix tracks together using EZ-Track Plus, there is no
generation loss; it's merely a clever manipulation of numbers. You may
combine tracks as often as you need without any sound quality change. If
you need more than 20 tracks, you can MIX tracks together down to one
destination track, and delete the source tracks.

To MIX Tracks:

e Select Mix Tracks from the Edit menu

e Select the tracks you wish to MIX with the LEFT button (1 to 20 tracks)
* Each track selected will reverse hlghllght

Bi: Mix This Track =I.'l 81
B2: ...And This One 0 <F3 Bl
B03: ...And This One ¢  cE} BiZ
| »84: Mix of 1, 2, & 3 ¢ 80
8s5: ¢ 1]V

* Sclect an empty track
¢ Click the RIGHT button to save the mix

The tracks you selected are now combined onto one track.
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If you combine tracks that are assigned to different MIDI channels, each of
these tracks will retain their MIDI channels, even though all the
information is stored on one track.

If you MIX this:
B81: Keyboard ¢ <E8 814
B2: Bass & <k 0617
»83: ) 80%
04 o 80%

Track 1 contains Keyboards assigned to MIDI channel 1
Track 2 contains Bass assigned to MIDI channel 7
Track 3 is just about to be a Mix of Tracks 1 and 2

Track 3 will contain the keyboard part, which will still be assigned to MIDI
channel 1, and the bass part, assigned to channel 7. If you mute tracks 1
and 2, and play back track 3, you will hear both the keyboards play on
channel 1 and the bass play on channel 7.

You can also use this function to permanently change the MIDI channel
assignment of a track. For example, let's say track 5 has information
recorded from MIDI channel 1. You assign that track to play out MIDI
channel 3. Now (for some reason) you want to permanently have all of the
events on that track be set to MIDI channel 3. Select Mix Track from the
MIDI menu and mix track 1 to track 1. This will change all events from
channel 1 to 3.

Note:

If two tracks are assigned to the same MIDI channel, mixing them will
combine the channel information, and it will be impossible to separate
(unmix) the different parts back to their original tracks.

To MIX TRACKS From The ST Keyboard:
* Press Control M. This will bring you to the initial prompt box.

1! Use LEFT 2: Use RIGHT
button to! button to:

Select tracks Select
to MIX destination track

Use UNDO key to CANCEL
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Unmixing Tracks

You can unmix a track by MIDI channel assignment. What you'll be doing is
extracting selected information from a track and placing that data on
another track, leaving the original one untouched.

Each note is always recorded with a MIDI channel assigned to it. It is easy
then, for EZ-Track Plus to search through a track and copy notes with
specific MIDI channels, and store that information on another track.

Unmixing allows you to make additional individual edits (for example,
Quantize a specific part) to previously-mixed tracks. You can also
reorganize your song if you recorded tracks using multiple channels (from
other sequencers or split keyboards).

To UNMIX A Track:

¢ Select Unmix Track from the Edit menu

¢ A prompt box appears with 16 MIDI channel numbers

e Click on the MIDI channel(s) you want to copy from the track you select
e Click OK

' The channel box(es) will reverse
Copy events on channel(s): highlight to show you which ones
2 l 3 I 4T5 I 6 I 7 l 8] you've marked. If you change

your mind about any of them,

t point d click d ti
(S T18[1T12[ BT TIS[16] | S Pouil Go-selest the channel.

L0k ] [ Cancel ]

e Click on OK.
¢ Select the track you wish to UNMIX with the LEFT button

1: Use LEFT ' 23 Use RIGHY
button to: : 3 ‘

Select track - ’ piec d
to UNMIX destination track

Use UNDD key to CANCEL
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If you select a track that doesn't have several MIDI channels mixed in, there
isn't going to be much of a result. You are extracting information that is
assigned to specific MIDI channels that you previously combined.

From our example, select Track 4 to Unmix MIDI Channel 1's information.

81: Mix This Track ¢

83: ...And This One @ <E} 01z
04: Mix of 1, 2, & 3 ¢ c B34
85: Unmix MIDI Ch 81 ¢ 86%
[ ity 887z

¢ Choose the track you want to Save the Unmixed information To with the
RIGHT button (move the arrow selector to the destination track and click
with the RIGHT button)

The information from MIDI channel 1 is now stored on track 5 (Track 5 is
also a copy of track 1)

1! Use LEFT 2: Use RIGHT
button to: button to:

Select track Select
to UNMIX destination track

Use UNDO key to CANCEL
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Ir D

It helps to have complete control over where tracks sit in relation to each
other. This can adjust the "feel” of the song. If you slide the Kick track just a
little bit early so it plays more on top the the track, you'll find your music is
much more "set in the groove".

Another use for this function may be to compensate for sounds that have
slow attacks and therefore sound "late".

The Track Delay function allows you to offset each track in time relative to
the other tracks. You see all 20 track delay settings at the same time.

To Set The TRACK DELAY:
» Select Track Delays from the Options menu
* A window appears covering the right side of the screen

81:
02:
a3:
04:
85!
86!
87:
08!
89:
10:
11

Track
Delays

-
e N

15:
i6:

-
0 0~

L I I T I S S IS

=~ --N - NN N--W--N--]

20!
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¢ To the right of each track number is a positive or negative number. This
represents each track's relation to the downbeat of measures:

0 is right on the beat
- plays earlier
+ plays later

¢ Point to a track's offset number

¢ Use the RIGHT button to increment or the LEFT button to decrement

¢ Setting the number in the negative range will make the track play earlier
¢ Setting the number in the positive range will make the track play later

¢ Each track can be adjusted early or late over a range from -90 to +99 ticks
¢ Once all of your track adjustments are set, click OK

If you MIX a track which has a non-zero Track Delay setting, the delay
permanently changes the timing of the destination track. All other
functions copy the Track Delay setting from the source to the destination
track. The actual times within the track remain the same relative to the
original track.

For example, if a track contains a note that starts at beat 00004.00, and a
Delay of -10 is set for that track, it will play the note at 00003.86. The note
event within the track is still at 00004.00, but the Delay value is affecting the
playback. If you Copy the track, the resulting track will also have the note
event at 00004.00 and a Delay value of -10. However, if you Mix the track,
the resulting track will have the note event at 00003.86 and the Delay value
will be set to + O.
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Impeorting Tracks
EZ-Track Plus allows you to merge separate songs and individual tracks. If
you had a particularly favorite groove you'd recorded and saved, and wanted

to add it underneath a new song you were working on, you could import the
tracks from the original file into the current file and see how it sounded.

To IMPORT A Track:

¢ Select Import Track from the File menu

e An Item Selector appears with the directory of the song files on the disk in
the Current Drive

» Select the song file which contains the one track you want to Import

¢ Click on the name of the file. The name is automatically transfered to the
selection line.

ITEM SELECTOR

Directory:
A:\¥%,SHG

i Selection;
o | SSONGS . SNG|

8 AUTO o\ __

MENDPRL1.SHG
MOOHJIG .SHG
QUESTION,SHG

SIMPSAMP , SHG

e e et e e e e e 0 e e 6

(Make sure the disk in the drive contains at least one song file with an
extension of .SNG)

¢ Click OK
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The song file quickly loads into EZ-Track Plus and superimposes the track
titles over the current tracks. It has NOT replaced your current tracks, but
is only providing you a means of seeing what tracks exist in the song file.

¢ Select the track you wish to Import
The mouse now controls the track selection arrow
¢ Click the LEFT button once

01 Toccata & Fugue © 9 017 |

(]

|| »82; Bumble Bee ¢ Bl g

03! Sonatina o £ 017 |
84: Piece #4 ) iz 8
85: Maple Leaf Rag S (1 WAV
86! S 08% #
87: Solo each track & 807 |
88: then PLAY to ) 00% §
89: hear any one of & gex &
18: the five songs. & 007 &

Almost immediately, the screen returns to the display of the current song.

¢ Choose an empty track to store the new Track
* Click the RIGHT button

The track you selected is read off of the disk and stored on the new track of
the current file. All information is transfered including the track name and
channel assignment. The new track arrives muted to avoid confusion with
the current setting. To hear it, turn it ON (Unmute it).

@ 007 |

o 08% &

! ¢ 087 &

i #04: Bunble Bee o <@ ol g

" o 0oz ||

86: o ooz ||
az: 1) 1] P
8: @ ;P

89: ¢ 007 §

10: e 007% &
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In This Chapter:

e Velocity Adjust
e Meter/Metronome Option
e Glue Section (Cut & Paste)

Key Words:

¢ Glue Section
e Section
e Velocity
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ADVANCED EDITING FEATURES

There are further options to improve or adjust your performance and
increase the number of arranging possibilities.

Velocity Adj

An adjustment you may want to make to the overall performance of your
music is the relative volume of one track to another. In an analog multi-
tracking situation, this is referred to as mixing. Although EZ-Track Plus is
not an automated mixing console, you can, to a certain degree, adjust the
relative levels of different parts and tracks.

Most synthesizers have velocity sensitive keyboards. Velocity sensing is a
matter of detecting how fast you press down on the key from the top of the
key to the bottom of the keypad -- a measurement of distance vs time. If you
press a key fast, the instrument measures this as a maximum velocity of
127; the slowest pressing of a key registers as a velocity of 1. As a general
rule, when you press slowly, the sound is softer, and when you press faster,
the volume increases.

EZ-Track Plus allows you fine tuning of velocity information. This is
dependent on how your instrument is programmed to respond to velocity.
If an instrument you have is not velocity sensitive, you won't hear any
difference; if it is velocity sensitive but the patch is not using the velocity
parameters, again you won't hear any change.

Velocity Adjust Options:

RN R R RN

R R SRR RO AT O AT P

]
0 MIDI Velocity Range 128




To ADJUST VELOCITY:
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e Select Velocity Adjust from the Edit menu
¢ A series of dialog boxes appear giving you options to alter the velocity

fidjust which velocity?

The first dialog box asks which velocity
you want to adjust: Attack (how
quickly you strike the key), Release

Eﬂttack I [Release] [ Both | {)h(gln quickly you let go of the key) or
oth.

Release velocity is dependent on whether or not your instrument is
programmed to take advantage of this parameter. Some sounds can be
made to ring out or change depending on how fast you let go of the key.

Velocity adjust method:!

[Shift] [ Set |

The next dialog box prompts you to select
one of two available adjustment methods:
SHIFT or SET.

SHIFT VELOCITY  shifts the overall velocity of the track softer/louder.

SET VELOCITY sets velocity at a specific level for all notes on a track.
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Selecting the SHIFT method provides a dialog box that requests which shift
direction you want: SOFTER or LOUDER. Follow the map below for the
Prompts and alternatives.

The following diagram shows the various paths you can take through the
SHIFT Velocity dialog boxes:

Velocity adjust method:

Shift direction:

|Softer| |Louder|

Shift velocity by (1..126): 806

[ ok | [ Cancel |
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SHIFT EXAMPLE

Let's take a track with 3 notes, the velocity of the first note being 100, the
second note 50 and the third note 30. Set the Shift direction Softer by 20.
The resulting note velocities would be 80, 30 and 10 respectively.

<y 80

Y

NN 50

W

WY

NN

NN

NN

MR

RN

NN 3

N TR

W N

WRW NN

AN N

AN NN

NN W

AN W RN
1 WAL AN NN
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Set velocity to (1,.127): B64|

[ oK 1 | _Cancel |

1: Use LEFT
button to:

Select track Selent
to ADJUST destination fratk

Use UNDO key to CANCEL

Selecting the SET method
simply means that you will
adjust ALL velocities on the
track to one value.

Once you've selected the
method of velocity adjustment
you desire, and set the
necessary parameters, you
have one last step. Using the
Track selection arrow, point to
the track you wish to adjust,
and click with the LEFT button.
The track will highlight to
designate that it is marked.
Choose the track you want to
store the velocity adjustments
to and click with the RIGHT
button.

[To ADJUST VELOCITY From The ST Keyboard:
» Press Control V. This will bring you to the initial dialog box
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Beats Mode Beats Ticks
Until now, all time displays I 1

have appeared in Beats Mode: 80000,00

In this Mode, the Metronome always clicks at a quarter-note rate (one click
per beat).

Meter Mode
Most musicians are familiar

Beats
with another form of timing
display, which EZ-Track Plus Mea,ﬂ‘f, |_| I'T%ks
calls Meter Mode. It shows 8601]01,00
you time in measures, beats

and ticks:

A time signature is displayed in this Mode, and the metronome clicks every
quarter or eighth note, with an accent on the first beat of each measure.
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To Set METER/METRONOME Parameters:

¢ Select Meter/Metronome from the Options menu

e A dialog box appears allowing you to set parameters regarding the
Counter and Timing display information

Display: le These functions (Display,

Metronome tick, and Lead-

Hetronome tick: 174 1/8 in Measures) will only work
- if you are in Meter Mode (see

Lead-in Measures: explanation of each function
m III on the following pages).
Display Mode: R:LLLLH::§ (0081]01,88

I oK | [ cancel ]

* Set the desired values for each of the options presented in the dialog box
(See descriptions, next page)
¢ Click OK

To Set The Display Numerator Value:

¢ Use Backspace to move the cursor

¢ Type in a value between 2 and 16 if using a denominator of /4, or 2 and 17
if using /8
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[Display: |

This is a time signature which affects all displayed time values and which is
also displayed on the main screen. The first number (which is entered
using the keyboard) is the numerator which has a range of 2 to 16 or 17.
The denominator is selected by clicking on one of the 2 buttons.

[Metronome Tick: |

The two available settings allow you to switch between quarter-note or
eighth-note clicking.

The setting (selected by clicking on one of the 2 buttons) is the note value for
the metronome click. For example, if set metronome Display to 4/4 and click
on 1/8, you will hear a metronome click every eighth note with an accent on
the first beat of each measure.

1 2 3 4 5 6 7 8

TICK tock tock tock tock tock tock tock
TICK tock tock tock tock tock tock tock
TICK tock tock tock tock tock tock tock

If you set the Display to 2/4 and click on 1/4 you should hear someting like
this:

1 2 1 2 1 2 1 2

TICK tock TICK tock TICK tock TICK tock
TICK tock TICK tock TICK tock TICK tock
TICK tock TICK tock TICK tock TICK tock

Display: B4

Metronome tick: 1/4 1/8
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{Lead-in Measures: |

Lead-in is a space of time before the music starts playing. EZ-Track Plus
allows you to renumber the first 2 measures as Lead-in measures. Since
this is only a renumbering, you can still record and play back during these
measures (an example might be to use this for a pick-up measure}.

If you use two Lead-in measures, the first measure is shown as . . . 1, the
second as . . . 2, and the third (presumably the first measure of music) as
0001.

Lead-in Heasures: n

Note:

You can skip a Lead-in by setting the Start Time to 0001101.00 and
activating Auto-Locate. Setting Lead-in Measures to None will not remove
time from the beginning of your piece.

|Display Mode: |

The left choice is Beats Mode. The right choice is Meter Mode.

Display Mode: |00008.008| LILINLIRL




Using Meter Mode
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If you choose to use Meter Mode, ALL counters will display as
Measures | Beats.Ticks, and they will adhere to the basic meter settings.

B a4 g

L

—B[e8e1101.68]¢
@’°

» (5000104, 95]¢
—H[5808184.95¢

A time signature is displayed to the right of
metronome on the main screen.

This Mode changes the way time is
displayed but does not change any
previously-recorded information. If your
preference is to work with beats as opposed
to measure references, then click on
00000.00 in the Meter/Metronome option.
If you find it easier working with a visual
representation of Measures and Beats, it's
available to you as well by selecting
0001101.00 instead.

If you prefer to always work in Meter Mode, you can set this up easily using
the AUTOLOAD.SNG feature. See Chapter 6.

Value Settings

Beats Mode  Highest Value = 19999.95

Meter Mode Highest Value = 5000104.95 (in 4/4, with no Lead-in)
Highest Value = 10000104.47 (in 4/8, with no Lead-in)

Displayed As:

+++0104.47

Since there is only room to display a 4-digit measure number, any value over
9999 is shown as +++0. The purpose of having values that high is to be able
to set the Punch-Out or End times to values you'll probably never reach, so
it's not important if you can't see the exact value.
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GLUE SECTION

EZ-Track Plus can define any portion of a track as a Section. You can then
Glue that Section to a new starting time.

Creating A Secti

A Section is a two-dimesional "slice" of music. It consists of music between a
start and end time, on one or more tracks.

Defining A Section

opoeo.08 60084.00 06008.00 00012,00 00816.08

01-60 | 2

01 e
TrocksI :

Time ——
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To Create A Section:
e Click on the Cash Register
(This tums the Locate Display into the Section Display)
e Set the Start Time for the Section
e Set the End Time
¢ Select the track(s) you want to include by clicking on the Track Name

Below the Section Icon are the Start and End Times. Adjusting the top Time
sets the Start point of the Section, adjusting the lower Time sets the End
point. Click on each digit to set the time.

The End Time defines the End of the Section but is not included in the
Section. In other words, the Section begins at the Start Time and continues
up to but not including the End Time.

Once you've set the Start and End Times, you need to select the tracks you
want to include in the Section -- up to 24 tracks.

To Assign Tracks To The Section:
¢ Click within the Track Name area
(the tracks will reverse highlight)

To Remove Tracks From The Section:
e Click on a highlighted Track
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Let's step through an example. This is the story so far...

We have recorded a drum part on track 1, a keyboard part on track 2, and a
bass part on track 3. Assuming we are in Beats Mode, all 3 parts play from
00004.00 to 00012.00 (the end time defines the End of the Section BUT IS
NOT INCLUDED IN THE SECTION). We'll call this part our Verse. What
we've going to do now is create a Section, including these 3 tracks, and then
preview it.

¢ Click on the Cash Register to switch to Section Mode

&

2

—[_80884.88 |¢

I

e Define the Start and End ﬂ |:| Py
Times for the Section

—s| §08iz.08 |<¢

Click on tracks 1. 2. and 3 ¢ ¢
¢ Chck on tracks 1, 2, an 0 02: Keyboard ¢
include them in the Section %
04: &
2B
. Toti prtevi(;,;wt ttie Stection‘i —3| 08604.00 |¢
activate Auto-Locate an
click on PLAY ﬂ’l:]o'
o[ e
—]| 080812.088 |¢
868066.00

= g OO
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| Setting Section Times |

1]
Secti Click Amows to set
ection time to the current
Start I 00004.35 |G— Counter time:
Time ::l o with LEFT button

¢' to set the time to
I:l ¢| the exact tick

o with RIGHT

button to round to
00004.33\]
——

the nearest beat.
Counter Reset  Counter

Section
End r
Time

Click on individual
diglts to set times

Notes For Defining The Section

* In Section Mode you still have the ability to Auto-Locate by clicking on
the Auto-Locate Enable Bar.

¢ Make sure the Start Time is less than the End Time. Otherwise the
Section will be given a length of 00000.
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Cut & Paste (The Glue Section Feature)

Most word processing programs contain features that allow you to outline a
block of text and move or copy that block anywhere within the body of the
document. This type of cut-and-paste feature is mirrored in EZ-Track Plus
but implemented for music processing. You can select any start and end
points within multiple tracks (or a single track for that matter), and copy
this section to any other time location, early or late. As always, the original
tracks are unaffected, providing you store the pasted version on an unused
track.

To Glue A Section:

¢ Define the Section

¢ Click on the Section icon (the Cash Register reappears)
e Set a Start Time where the copy of the Section will begin
¢ Select an empty track

e Select Glue Section from the Track menu

¢ Click OK

Note:

You must select the track BEFORE you proceed as you are not prompted to
select a Destination track. If you don't select the track you want to paste the
section to BEFORE you proceed to the next step, you'll have to start again.

To Glue A Section From The ST Keyboard:
e Press Control G

Glue Section

00000.00 00PO4.00 00008.,80 060012,00 08016.00

01
Tracks
01-60 | 92

03

04 ———— P

A 4

Time —
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Let's use our example from Create Section and Glue the 3 tracks so they all
start at 00012.00 on another track. If this is done right, then our Verse will
play 2 times, one after the other.

e The Section is already defined (from 00004.00 to 00012.00 including
tracks 1, 2, and 3)

¢ If you are in Section Mode, click on the Section icon to return to the Cash
Register

¢ Set the Start Time to 00012.00

it

r—B[_ee8iz.08 J<
E m

19399 [ 19999,95 |

—Em

e Select a track (we'll use track 4 since it is empty)

[E!Bu l

Bl Druns S

o
82: Keyboard ) [1 WAV
83: Bass ) B 01z §
o 04 o 08% A
| 05 o 88% |
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¢ Select Glue Section from the Track menu
¢ Click OK

6lue section
(at current locate time)
to selected track.

[ ok ]| [ Cancel ]

Notes For Glue Section

¢ It does not make sense to Glue a Section of 00000.00 length, nor does
it make sense to Glue a Section with no tracks selected, because you
will end up with an empty destination track.

» Since a Section can contain multiple tracks, but Glue Section places
the result on a single destination track, all the rules about Mixing
regarding MIDI Channels apply.

¢ Glue Section creates a new track which only contains a copy of the
Section at the new Start Time. If you want to combine this copy with
the original, use Mix Tracks (see Chapter 4).

* You can Glue multiple copies of the Section at different Start Times
fairly quickly. Set a new Start Time, select a new destination track, and
select Glue Section again. After you've made multiple copies, you may
want to Mix those tracks together.




CHAPTER 6
GLoBAL FEATURES

In This Chapter:

Global Transpose

GenPatch Accessory

Multiple Instrument Setups
MIDI Mode Messages

MIDI Input Filters

Naming A Song

AUTOLOAD / AUTOPLAY Files
Erasing A Song

Punch & Quantize Methods
Safety Features

Key Words:

Global

Local ON/OFF
Mono Mode
Omni ON/OFF
Patch

Poly Mode
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Global features are functions which affect the overall performance of the
program. Some basic functions, such as Tempo adjusting and the
Meter/Metronome option, have already been covered earlier in the manual.
This chapter covers the remaining Global features.

GLOBAL TRANSPOSE

You can instantly transpose the key of the entire song by a range of 4
octaves, up or down by half-steps. This is a real-time control, meaning you
can alter the key while the song is playing.

]« [@]

To Transpose The Entire Song:

¢ Point to the accidental symbol (it defaults to a Natural sign)

¢ Click the Right button

¢ The accidental now becomes a sharp with the number 1 next to it

ILLAE

To Set The Amount Of Transpose:

¢ Click the Right button to increase the overall key by a half-step

¢ Click the Left button to decrease the overall key by a half-step

¢ A Sharp accidental appears when you are above the original key .

¢ A Flat accidental appears when you are below the original key

e The value shows you how far away from the original key you've
transposed

e If you click the Transpose icon, you can transpose by an octave at a time

Changing the Pitch:

Click here to
transpose by Octaves

Lower  Higher
Click here to N
transpose by Half-Steps

A

Click here to exempt
a MIDI Channel from transposition
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To GLOBAL TRANSPOSE From The ST Keyboard:

¢ Press the RIGHT ARROW Key to raise by a half-step

¢ Press the LEFT ARROW Key to lower by a half-step

e Press the Shift RIGHT or Shift LEFT ARROW Keys to transpose by an
octave

Directly to the right of the Transpose indicator is a box with a MIDI channel
number in it (the default is 16). Whatever MIDI channel is assigned in this
box IS NOT affected by global transposition.

Most drum machines, while having built-in sequencers, can also be
triggered via MIDI (like other instruments). When you use them this way,
each drum sound is typically assigned to a particular note. If you were to
Transpose a drum track, the wrong drums will play.

For example, let's say a kick drum is assigned to F1 and a snare to G1. If
you Transpose up by 2 half-steps, the snare will play wherever the kick used
to (some other drum sound may also play wherever the snare played
previously).

By setting one MIDI channel to not be affected by Global Transpose, you can
tune your drums to this channel and they will not be shifted with the rest of
the music.
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GENPATCH ACCESSORY

EZ-Track Plus comes with a desk accessory which allows you to load Hybrid
Arts' GenPatch ST files without leaving the program. GenPatch ST is a
generic patch storage program that will store patches from a variety of MIDI
instruments. If you store your patches using GenPatch ST, then you'll find
this accessory invaluable as your entire sound catalog is always accessible
from your sequencer.

Notes For LOADING ACCESSORIES

The GenPatch (or any) Accessory will only be under the Desk menu if you
properly load your disk. Accessories load into the memory of your
computer when you first turn on your computer. The disk in the "loading”
drive should contain all of the accessories you want to use.

When you turn on your computer, the loading drive boots the computer
by first initiating the operating system and then looking at the load disk
for ANY file with an .ACC extension. These are ACCESSORY files. It loads
all of these files from the beginning of memory to as far into memory as
there are accessories on the load disk. Keep in mind each accessory
loaded uses up memory -- Note Memory for your sequence.

If an accessory you need is not on the load disk, you must insert the disk
containing that accessory into the load drive and reset the computer.
Keep in mind that doing this will clear all memory and begin the loading
process again.

The EZ-Track Plus master disk contains the GenPatch Accessory file. So,
if you properly load your master EZ-Track Plus disk, the GenPatch
Accessory will load correctly.
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To Use The GenPatch Accessory:
¢ Select GenPatch from the Desk menu
¢ Place the disk containing your GenPatch file in the current drive

GenPatch Accessory 1.3

| Load File (L) | [ TYransmit (D |

¢ Click on Load File (or press L)
¢ The directory lists all files (including GenPatch Files) that are on the

current disk

ITEM SELECTOR

Directory:

Selection: ¢ Select the bank of sounds
BRASSES .DX7| you want to load

ANDROIDL.CZ. [ %

BRASSES .DX7

CHRISOUN.HT6

STRINGS .D50

R

T L [rancer] |

________ — o

¢ Click OK

The file will load into the ST's memory. 0 :hlfi:n;;'{:shlgltllg'.t

If the file you attempt to load is not a
GenPatch file, the following prompt will
tell you this:
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Next you'll need to ensure that the instrument you're going to transfer the
sounds to is properly prepared (correct MIDI channel, write protect off, etc).
Refer to the particular instrument's owner's manual for specific transfer
instructions.

¢ Once your instrument is set to receive, click on Transmit File (or press T)

e Some files may require additional information such as which MIDI
channel to transmit on. If this is the case, type in any needed information
then Press Return

e The GenPatch Accessory always numbers patches from O to 127

GenPatch Accessory 1.3

| Lead File (L) | [ Transmit (T |

File Information: CZ-Android
Transmit on MIDI channel (81-16): 81

The mouse becomes a MIDI Plug telling you to wait a moment while the bank
is being transmitted.

Your instrument is now loaded with the new sounds.

GenPatch Desk Accessory Notes

e EZ-Track Plus will not store patches or banks of patches for you. The
GenPatch Accessory is simply a convenient method of utilizing and
integrating Hybrid Arts' products with one another.

¢ CZ-Android and DX-Android Files can be converted to GenPatch ST
format. Once they are, you can transfer them using GenPatch
Accessory WITHOUT NEEDING GENPATCH ST. The two different
conversion programs are included with the Android programs.

e Also, because this is a Desk Accessory, the patches can be loaded
from within any program. For example, say you're writing something
using a word processor and you want to practice something on your
instrument using different sounds than the ones currently in it. If
the GenPatch Accessory is loaded correctly, you can load new sounds
without having to Quit your word processor.
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MULTIPLE INSTRUMENT SETUPS

Using The Thru Funci
If you are using more than one MIDI instrument with EZ-Track Plus, you
may want to play and hear them using the Thru feature.

Multiple-Instrument L
Hookup: Drum Machine
vi n|alw]als{x]
In Thru Synthesizer
MIDI
1
In Out Thru i
nMLI'DI Synthesizer
3] |8y
In Out
W0 |
ATARIST

0 0 0 ) |
§ 1 (7 I ) )V “I
] ) ) § |l il
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To Turn The Thru Function ON or OFF:

¢ Click inside the box to the left of the word Thru

« If the check is not there, when you click, it will appear. Thru is active.
e If the check is there, when you click, it will disappear. Thru is inactive.

Any instruments connected and tuned to the MIDI Channel shown
(channel 2 in the example) can now be played from your main keyboard
through the computer.

Thru (B3]

If you set your instruments to different MIDI channels, you can adjust
which one(s) you'll play by adjusting the Thru Channel.

To Adjust The MIDI Channel Number:

¢ Click on the MIDI channel number shown to the right of the word Thru
¢ Click the RIGHT button to increase it

¢ Click the LEFT button to decrease it

Using the example setting above, if you tune an instrument to MIDI
Channel 2, you'll be able to hear both your main instrument play together
with the other one set to MIDI channel 2.

Unchannelized Thru

There is one setting which causes the MIDI channel number to disappear.
This represents a feature allowing you to send MIDI information from a
controller that can send more than one MIDI channel at a time Thru to
instruments set to those separate channels.

Example 1: Using a keyboard that is capable of sending more than one
MIDI channel at once, you can control different
instruments set to corresponding MIDI channels.

Example 2: Guitar controllers often send a different MIDI channel for
every string. In this case, a useful application would be to
use a synthesizer set to MONO Mode where each voice
corresponds to a different string.
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Local Control

Local Control ON / OFF is a MIDI function which allows you to separate
your keyboard from its sound part. (This function is not available on all
instruments.)

Instruments capable of turning Local Control OFF are equivalent to having
two parts: a sound part and a keyboard part, both of these parts packaged
in one unit.

Local Control Definition

Local Control ON:
Keyboard controls the Sound Part

sussan SOUNd Part seesscaa

Keyboard Part

Local Control OFF:
Keyboard is like a separate keyboard
and Sound Part is like a sound module

Turning Local Control OFF will separate the sound part from the keyboard
part. This allows the sound part to play as a "module" while the keyboard
part is triggering other instruments.
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An example might make this more clear:

You have a keyboard (containing the Local ON/OFF function) set to Receive
and Send on MIDI channel 1. You also have a rack module instrument set to
Receive on MIDI channel 2.

You record a bass part that uses the sound from the keyboard. You now
want to record a melody that uses the sound from the module.

While the sequencer plays the bass part (on the keyboard's sound part),
you play the melody part on the kéyboard, using the Thru function to hear
the melody on the module. But, with Local Control ON, you also hear the
melody on the keyboard's sound part because it's internally connected.

Solution: set the keyboard to Local Control OFF. This effectively separates
the two parts of the keyboard. Now when you play the melody, the
keyboard only triggers the module sound. You can then record the module
part at the same time the sequencer plays the sound part of the keyboard.

Module Sound
: lu:]nnuununnn :—k

1

Local Sound Atari ST Atari ST
”2Z2232223:‘335333333:332333 |¢— Playback Record &
ooopOonOoOoDOOODOOQOOOOCOOoOpDOCOOO Th[u
Connected if f
Local Controlis ON J

Keyboard Controller
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MIDI MODE MESSAGES

EZ-Track Plus allows you to send specific MIDI messages to your
instruments. These messages are general modes included in the MIDI spec.

To Send MIDI Mode Messages:

¢ Select Send Mode Msg from the MIDI menu

» A dialog box appears with all the messages you can transmit

¢ First choose the MIDI channel on which to send the message
(A1l will send the message on all MIDI channels)

¢ Click on the message to send it

Select MIDI channel: [JEXEH
[t]z[3[4f5]6]7]8]

[ 91811121314 15]16]

Select MIDI mode to send:
|Onni off/Poly] [Omni off/Mono]

{Omni on/Poly| | Omni on/Mona |
|811 Hotes off| | Tune Request |
| Local off | [ Local on |
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There are 8 Mode messages you can transmit:

Omni Off/ Poly

Omni Off/ Mono

Omni On/ Poly

Omni On/ Mono

All Notes Off

Tune Request

Local Off

Local On

Your instrument will receive MIDI information only on
the channel it is tuned to, and functions in Poly mode.

Your instrument will receive MIDI information only on
the channel (or a group of consecutive channels) it is
tuned to, and functions in Mono mode.

Your instrument will receive MIDI information on any
channel, and functions in Poly mode.

Your instrument will receive MIDI information on any
channel, and functions in Mono mode. (This Mode is in
the MIDI spec and is here only for completeness.)

Turns off notes, especially ones that may be "stuck” on.
This is recognized by some but not all instruments, so
it may not appear to function if your instrument
doesn't recognize this MIDI command.

Some analog synthesizers require tuning of their
oscillators periodically. Sending a Tune Request
causes this function happen. (Not all analog
synthesizers recognize this message, however.) This
affects ALL channels, regardless of the channel
selected.

This disconnects your keyboard from its sound part.
(See description above -- Local Control.)

This connects yoﬁr keyboard to its sound part. (See
description above -- Local Control.)
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MIDI INPUT FILTERS

This feature allows you to filter out MIDI events you may not want to record.
For example, After Touch messages eat up a lot of memory. If you don't need
After Touch, filtering it leaves more room for your music.

To activate the MIDI Filters:
¢ Select Input Filters from the MIDI menu
* A dialog box listing all the MIDI Input Filters available appears

MIDI Input Filters:

After Touch: Filtered
Pitch Bend: Filtered
Controllers: Filtered
Program Changes: Filtered
Note On/Off: Filtered
Mode Commands:
A1l Notes Off! Filtered

To Enable Or Filter Out A Controller:
¢ Click on your selection

For example, EZ-Track Plus defaults to filtering out After Touch. This
means you will NOT record After Touch messages unless you select the
Enabled box. It also filters our All Notes Off messages (a MIDI Mode
message, not to be confused with Note Off), which should be unnecessary
but can cause problems in overdubbing situations if enabled.
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NAMING A SONG

You can give your song a title (up to 32 characters). This title will remain in
the Song Name display. THE SONG NAME IS NOT NECESSARILY THE
SAME NAME AS THE SONG FILE NAME ON THE DISK (See below).

To NAME A SONG:

¢ Select Name Song from the Edit menu
e Type in the title of your song

e Click OK

Song name: The BEST TIME (in my life)L _____

[T ok 1 [ cancel |

It appears in the Song Name display.

The BEST TIME (in my life)
version 8

Types Of Names: There are 3 independent types of names per song:

1-Track Name 16-character name. One name per track.

2-Song Name Name of song. 32-character name shown at top of
Control Display.

3-File Name The 8-character name you give your song when you

save it to disk.
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AUTOPLAY / AUTOLOAD SONG FILES

When you run EZ-Track Plus,

it checks the disk for a file
called AUTOPLAY.SNG. If this
file is there, it loads and plays
the song. If AUTOPLAY.SNG
isn't there, the program looks
for AUTOLOAD.SNG, and if it
finds it, it loads the song file.

Since most things you set are
saved in each song file, you can
customize the program
defaults by setting up a blank
song the way you like and
saving the song file as
AUTOLOAD.SNG.

This is also good as a start-up
song. For example, if you name
the current song you are

ITEM SELECTOR

Directory:
A:\%,SHG

Selection:
AUTOLOAD, SHG|

@
—————————— —

working on AUTOPLAY.SNG,
then when you load the
program, that song will
automatically begin playing
right after the program loads.

230654 bytes used in 7 items

8 AUTO i
CONTROL ACC 20080
GENPATCH ACC 10458
DESKTOP INF 456
EZTRACK+ PRO 2432
EZTP REL 195470
AUTOLOAD SHG 1766

<] B

It will be saved on your disk and
should be on the same disk that the
program is on. It will appear on the
directory as shown. The next time
you load the program, in this
example, the AUTOLOAD.SNG will
also load.
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ERASING A SONG

When the program first loads, all of the settings that appear are the
program's factory default settings (a blank song, Start Time set to
00000.00, tempo =120, metronome ON, etc).

After you've been in session for a while, you may decide to start over. If this
is the case, select Erase Song from the Edit menu. This function resets the
current song to the factory defaults. It does not have anything to do with
any file you have on your disk; it only resets memory.

Note:

If you have an AUTOLOAD.SNG that has your preferred settings, then
instead of Erasing The Song, reload your AUTOLOAD.SNG using the Load
function from the File menu.

To ERASE A SONG:

e Select Erase Song from the Edit menu

* A dialog box appears verifying your request to erase the song in memory
(not the song saved on the disk)

fire you SURE you want to
v erase the song now in memory??

| Erase | |Canr.el|

¢ If you're sure this is what you want, click the Erase box

Be sure before you do this, because if you haven't saved the song to disk, it's
gone forever.
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QUANTIZE METHOD

This determines how EZ-Track Plus handles events when using the
Quantize function.

If you choose the Move Note Method, then when you Quantize a track, each
note will move to the correct timing point, without any change to the
duration of the note. Other types of events are NOT moved.

The Shift Attack Method causes just the front of the note (the Note On) to
slide to the correct timing, which changes the duration of the note. Any
other events between the old Note On time and the new Note On time are
pushed to the new Note On time.

Original
Move Note
Shift Attack

!

Time —

To Set The QUANTIZE METHOD:
¢ Select Quantize Method from the Options menu
e A dialog box appears offering you a choice of two quantizing methods:

Ouantize Method: Shift Attack

[ ok ]| cancel |

¢ Click on your selection
¢ Click OK
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SAFETY FEATURES

These are all contained in the Safety menu Entering Henu
and are toggled ON or OFF by pointing to the / Shift +9E 1
option and clicking. If the option is ON, a MW_E uuuuuu fjf”
small check mark appears next to the item; .
if it is OFF, there is no check. v Deleting

v Replacing
Entering Menu v Back Up Files

It most Atari ST programs, the menus drop down when the mouse is moved
into the menu bar area. In EZ-Track Plus, whenever a menu drops down,
the song stops. This is done to prevent timing delays (because the Atari ST
is not a multi-processing computer).

If Entering Menu is ON, then whenever you move into the menu bar area,
you must click the LEFT button to cause the menu to drop down (the song
will continue playing until you click).

If the mouse moves across the surface it is on (maybe caused by vibrations
from the loud music you are creatingl), it could end up in the menu bar area
causing the song to stop while you're in the middle of recording a "perfect"
take. Entering Menu ON prevents this from occurring.

shift + Enter

The default key command equivalent for KEEP is Shift Enter, to make it
hard to accidentally replace a track with unwanted information. (Shift +
Enter is ON).

Turning Shift + Enter OFF changes this key command to one key: Enter.
This makes saving a track easier.
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Delete Warning
If you select Delete Track from the Track

menu, a prompt will ask you if you're sure

? you know what you're doing (as long as the
v Delete track 1 7 Deleting option is left ON).

If the Deleting option is turned OFF (not
checked), then when you select Delete Track,

that's just what it does... no questions asked.
I-!)MI Mﬂl Make sure you don't want this track,
because even the best of us make mistakes
now and then.

Replace Warning

The Replace Warning appears when you
perform any action which ends up

replacing the track you select as a v Replace track 17
destination (as long as the Replacing
option is left ON).

If you turn the Replacing option OFF (not |Reglat‘.E| | Cancel |

checked), it assumes you intend to
replace the selected track with the new
information, and it won't ask you before
replacing it.
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Back Up Files

With this checked, each time you Save or Update a song, the program
automatically makes a backup song file of the previous version. The
previous version is renamed with the extension .SBK (song backup). (If

there was already an .SBK file with that name, then it is deleted from the
disk, and the new .SBK file replaces it.)

Vers|
/ ersion #4 \ Trash

Version #5
NN R
Jj J\ Verslon #3 %

.SBK

.SNG

All Gone!

To Load The Backup Version:

¢ Insert the disk containing the backup version of the Song File

¢ Select Load from the File menu

¢ Click on the Directory Line to move the cursor from the Selection Line
¢ Type the Backspace key 3 times (erasing SNG)

* Type SBK (the directory Line should now be: A:\*.SBK)

¢ Click anywhere on the scroll bar (this updates the listing)

¢ Click on the .SBK file you want to load

¢ Click OK
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If Back Up Files is not checked, then every time you try to Save or Update a
song when a song file by that name already exists, a dialog box will appear
asking what you want to do:

A file already exists by that
name, MWhat do you want to
do with it?

|Back It Up] [Replace It] [ Cancel |

Click Back It Up to have the program create an .SBK file (as described above)

Click Replace It to have the program replace the previous version with the
current one (a back up file is not created).
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CHAPTER 7
SYNCHRONIZATION

In This Chapter:
e MIDI Output Options

e Internal Sync
« MIDI Sync

Key Words:

¢ Chase
e Lock
* PPQ
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MIDI OUTPUT OPTIONS

You have control over several MIDI output options.

The MIDI spec has a provision for synchronizing to devices over MIDI. It
consists of the following:

Start. tells a MIDI device to start playing from the
beginning when it receives the MIDI Clock that
follows this event

Clock tells a MIDI device to advance a 24th of a quarter
note

Stop tells a MIDI device to stop playing (ignore MIDI
Clocks)

Continue tells a MIDI device to resume playing (from where

it stopped) when it receives the MIDI Clock that
follows this event

Song Position Pointer ... tells a MIDI device to locate to the 16th note a
specified distance away from the beginning of a
song

To Set Up The MIDI OUTPUT OPTIONS:
¢ Select Output Options from the MIDI menu
¢ A dialog box lists all of the MIDI Output options available:

MIDI Output Options:

Start/Stop/Clock! Enabled Disabled

[ Start/Clock Only |

Locate Method:  [Song Position Pointer |
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[Start/Stop/Clock |

Disabled means no MIDI Clock or related events will be sent. Use this when
you want to avoid triggering a drum machine, for example.

Enabled means Start, Clock, Stop, and Continue will be sent, per the MIDI
spec, whenever EZ-Track Plus plays.

A few drum machines (very few), don't recognize a Stop command, and
when one is issued they can tend to get confused. For these devices, the
Start/Clock Only setting should be used.

[Locate Method |

Song Position Pointer is also available to enable drum machines or other
MIDI devices that utilize this method of synchronizing to chase and follow
EZ-Track Plus.

Quick Clock is a method by which a very fast Clock rate is outputted
allowing certain drum machines to chase to where your song is located.

WARNING:
Some drum machines may crash (even lose their memory contents) if you
send them clock too fast. Use Quick Clock only if your drum machine

doesn't recognize Song Position Pointer. Back up the data in your drum
machine before trying Quick Clock.
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INTERNAL SYNC

There are 2 Sync Types available in EZ-Track Plus. Internal Sync is the
default and is indicated by the Atari logo in the Sync Selector on the Control
Screen:

Sunc

Internal Sync is a basic timing situation where the Atari ST is the source of
the timing. There is a quartz clock inside the Atari ST and all tempo settings
are referenced from this internal clock. The Atari ST is the "Master" in this
case, whereas in MIDI Sync it is the "Slave” to another device's timing
system.

MIDI SYNC

If you click inside the Sync Selector box, you toggle the Sync Type between
Internal and MIDI. MIDI Sync is indicated by the MIDI Plug in the Sync
Selector on the Control Screen:

Sync

In MIDI Sync, EZ-Track Plus no longer responds to its built-in Recording
Controls (except KEEP). Instead, it starts, stops, and continues under
control of an external timing device ("Master") connected to the Atari ST's
MIDI In.

EZ-Track Plus does not respond to Song Position Pointer as a slave. (It can
output it as a master -- see Locate Method under MIDI Output Options
above.)

The MIDI timing events will not be Thru'd.
If EZ-Track Plus is recording while in MIDI Sync, it will interpolate between

MIDI clocks (which are at a rate of 24 ppg) to maintain 96-tick recording
resolution.



APPENDIX A
APPLICATION NOTES

In This Chapter:

¢ Inserting Time In The Middle Of A Track
¢ Transferring Sequencer To Sequencer
e Transferring Drum Machine Songs
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INSERTING TIME IN THE MIDDLE OF A TRACK

Using the Glue Section function of EZ-Track Plus, it's not too hard to insert
or delete time in the middie of a track.

Let's say you've decided you want to add 4 beats between 00008.00 and
00012.00. You've already recorded from 00000.00 to 00012.00 linearly.

To Insert Time:

¢ Assign every track involved to a different MIDI channel

¢ Mix those tracks down to one

* Create a section for the first part up to where you want to irisert time
(Example, from 00000.00 to 00008.00)

¢ Glue this Section at the same Start Time to a blank track
(Example, Start Time = 00000.00)

¢ Create another Section for the second part which will be moved out
(Example, from 00008.00 to 00012.00)

¢ Glue this Section at a calculated new time to another blank t.rack
(Example, 00008.00 + 4 beats = new time = 00012.00)

* Mute (or Delete) the source track

e Optionally Mix the two new tracks together

Adding Time
p0000,00 00004,00 06008.00 D0D12,00 00016.00
Original —_ = =
Track —_— L - — {
. First Section, to be Second Section, fg .
. A t .
\ Glued at 00000.00 Abe Glued af 00012.0 0,
: i
After Gluing —_— i [ — = —_—
and Mixing —_ -_— ',?;?: ed . -—
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TRANSFERRING SEQUENCER TO SEQUENCER

You may have songs on another sequencer that you would want to transfer
to EZ-Track Plus. The problem is the Atari ST can't read the disks directly
(because the file formats are different). You can, however, communicate
using MIDI. To do this, you must sync both sequencers together.

To Transfer Sequencer To Sequencer:

¢ Set up both sequencers (turned ON, songs loaded)

¢ Connect the MIDI Out of the other system to the MIDI In of the ST
e Set EZ-Track Plus to MIDI Sync

e On the other system:

1 Assign each track to a different MIDI channel (It doesn't matter if they
are the correct MIDI channels or not, just as long as each part has its
own MIDI channel assigned.)

2 Set the Tempo to a very slow tempo (This improves the clock resolution
of the synchronization between EZ-Track Plus and the other system)

3 Set Output MIDI Start/Stop/Clock

4 Start the sequence

o If all is well, EZ-Track Plus will be in sync and the KEEP button will
highlight indicating MIDI data is being received

* When the sequence is complete, save the information to a track and select
Internal Sync on EZ-Track Plus

¢ Play back the track on EZ-Track Plus to verify the transfer

¢ Unmix the track so that each part is again on a separate track

You can reverse this process as well, going from EZ-Track Plus to another
sequencer.
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TRANSFERRING DRUM MACHINE SONGS

Drum patterns or complete songs can be transferred to EZ-Track Plus.

To Transfer Drum Machine Sequences To EZ-Track Plus:

e Connect the Drum MIDI Out to the ST MIDI In

e Connect the Drum MIDI In to the ST MIDI Out

¢ Set the Drum to MIDI Sync

¢ Set the ST to Internal Sync

e Set the tempo of the ST to a very slow rate (This improves the clock
resolution/ MIDI event ratio)

¢ Select Output Options from the MIDI menu

* Make sure Start/Stop/Clock is set to Enabled

e Start EZ-Track Plus

o If all is well, MIDI information will be sent to EZ-Track Plus, and the KEEP
button will highlight indicating MIDI data is being received

e When done, store the information on a track

¢ Set the Drum to Internal Sync

¢ Select Output Options from the MIDI menu

e Set Start/Stop/Clock to Disabled so that the drum sequence doesn't start
when you play the ST sequence

MIDI Output Options:

Start/Stop/Clock: Enabled Disabled

[ start/Clock Only |
* Play back the track on EZ-Track Plus to verify the transfer

The drum tracks on EZ-Track Plus can be edited just like any other track
(Mixed together, pasted via Glue Section, Quantized, etc.)

31
In Out -
In Out Thru
MIDI 112 E—
ATARIST Drum Machine
llEniisinininivinisisininimm} Hnmmnﬂ
w1t o




APPENDIX G
GLOSSARY

This is The Glossary:

° It Contains Key Words From Each Chapter
. It Also Defines Other Important/Relevant Terms
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AFTER TOUCH

Some MIDI keyboards can detect how hard you press down on a key once it
is all the way down. This pressure sensitivity is often referred to as After
Touch (you “touch” they key when you first play it; later when you press
down on it this is "after touch"). Many synthesizers can vary the sound of a
note by responding to After Touch.

There are two kinds of After Touch: Channel Pressure and Polyphonic Key
Pressure. Channel Pressure, commonly referred to as after touch, is the
most widely used. With Channel Pressure, all notes on a keyboard (and
therefore on one channel) are affected by one note's pressure changes, so if
you hold down a chord with your left hand, and increase the pressure on a
single note in the right hand, the pressure affects the left-hand chord as
well as the right-hand note.

With Polyphonic Key Pressure, on the other hand, each key has a separate
pressure sensor, and each note can be individually affected by pressure.
Because of the higher cost of individual pressure sensors per key, relatively
few keyboards have Polyphonic Key Pressure.

ALL NOTES OFF

A MIDI message that does just what it says: tums all the notes off. This may
be useful when you have some "stuck” notes. However, this is an optional
part of the MIDI Spec, not designed to replace Note Off messages, and many
instruments ignore it.

ATTACK
1. How fast a note reaches its maximum volume. Percussive instruments
have a fast attack, slowly bowed strings have a slow attack.

2. The beginning part of a note. Attack Velocity refers to how fast the key
travels down (at the beginning of the note); Release Velocity refers to how
fast the note is released (at the ending of the note).

AUTO-LOCATE
A feature that allows you to specify any point in the song and instantly cue
up to that point.
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BACKUP FILES
A duplicate of a file, usually stored in a separate place than the original.

BANK

Synthesizer patches are stored as groups of sounds known as banks.
Banks are a simple method of organizing or categorizing a group of sounds
Some synths contain more than one bank and allow you to switch from one
to another.

BEAT
In this manual, the tern beat usually means a quarter-note beat. This is the

basic unit in which EZ-Track Plus counts time within the song.

BOUNCE
The process of combining (mixing) separate tracks into one.

BOW-OUT
To mute (turn off) a particular track while turning every other track on

(unmuted).

BUFFER

Memory that that has been set aside for a specific purpose, usually as a
temporary storage location. The Record Buffer's purpose is to hold all
recorded MIDI information until you KEEP it (store it permanently) to a
track.

BYTE

A fundamental unit of computer memory. It is a grouping of eight bits (a bit
is a "binary digit" that has a value of either O or 1) with 256 possible values.
For example, a byte may represent a note number, or one of the letters of the
alphabet.

CHANNEL
See MIDI CHANNEL
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CHANNEL PRESSURE
See AFTER TOUCH

CHASE

Chasing means synchronizing to a tape sync source no matter where
within the sync track you start. In SmpteTrack, you can chase to anywhere
in the song almost instantly by using SMPTE sync.

When working with analog machines such as MTRs (Multi-Track
Recorders) and VTRs (Video Tape Recorders) that have physical transports,
chase refers to the time it takes for one machine to lock up to the other one
(the slave machine chases after the master machine until they are synced).
This can take up to 20 or 30 seconds.

CLOCK
1.  An electronic timing pulse for use in synchronizing sequencers with a
common timing reference.

2. A breakdown of a (quarter-note) beat into 24, 48 or 96 units. MIDI
synchronization is based on 24 clocks per beat. EZ-Track Plus divides its
beats to a resolution of 96 clocks or divisions of a beat. Also known as
TICKS.

CONTROL CHANGE

The MIDI assignment of numbers for different types of controllers. The
sustain pedal has specific Control Change number that almost all synth
manufacturers adhere to, #64. Other numbers can represent other
controls, such as a MIDI volume pedal (#7), mod wheel (#1), or breath
controller (#2).

COUNTER
A numerical representation of where one is located in the song (either in
beats.ticks or measures | beats.ticks).
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CUE

1. To locate to a particular point in the song, as in cue up. Clicking either
Play or the Reset Button in EZ-Track Plus causes it to cue to the beginning
(or Start Time if Auto-Locate is enabled)

2. A piece of music (or a sound effect) written for a specific section of a
visual medium, such as film or video.

CUT AND PASTE

The action of cutting (or copying) a section of information (text in a word
processor, music in a sequencer) from one place and placing it somewhere
else.

DEFAULT

A predetermined starting value for a setting. When you run EZ-Track Plus,
it starts with a tempo value of 120 BPM; thus 120 BPM is the default tempo
setting. If you use the AUTOLOAD.SNG feature (see Chapter 6), you can
change the default, so that, for example, the program always comes up set
to 110 BPM.

DESK ACCESSORY

A mini-program that is loaded into memory when the Atari ST is turned ON
or reset. Accessories MUST be on the disk in the main drive at that time.
These programs stay in memory until you turn the computer OFF or reset.
Use Accessories by selecting them from the Desk menu.

DURATION
The length of a note from the point a Note On message occurs to when a

Note Off is issued.

GLOBAL
Having to do within overall functions; ie; a global transposition will affect all

the tracks in the song.
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GLUE SECTION
The action of relocating a section of a track to another point. See CUT AND
PASTE.

HEX

Short for Hexadecimal, meaning base 16. Computers deal in a binary
universe, as electronics easily translates to an ON/OFF state of affairs.
Whereas decimal (base 10) counting involves 10 digits from O to 9,
hexadecimal involves 16 digits (O to 9 followed by A to F) Exactly two hex
digits can represent a byte value (between 0 and 255, written as FF in hex).
Thus hex can sometimes make the meaning of computer data more obvious
than decimal would.

ICON

A symbol or image used to represent a concept or physical device. For
example, in EZ-Track Plus an icon of a boxing glove represents the Punch
feature.

INTERFACE

1. The method of communication and interchange between a user and a
program. There are several means of interfacing with EZ-Track Plus, either
with a mouse or the ST keyboard.

2. A device for making such communication possible. A MIDI interface
(built-in on the Atari ST, but an extra option on other computers) provides
the circuitry necessary to communicate via MIDI. The Sync Box that comes
with SyncTrack or SmpteTrack is an interface to tape decks and drum
machines.

3. Interface is also used to denote the ease of use of this communication
process between program and user.

LOCAL ON/OFF
A MIDI command which allows separates the keyboard part of a keyboard
instrument from its sound-generating part. See description in Chapter 6.
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LOCK
A term describing a condition when two devices are in synchronization with
each other.

MASTER
In synchronization, the device that determines the timing for all other
connected devices (SLAVESs).

MIDI

Musical Instrument Digital Interface. The hardware interface and
communications protocol by which electronic musical instruments
communicate with each other and with computers.

MIDI CHANNEL

One of 16 separate channels used to communicate MIDI information.
Synthesizers, drum machines, and other MIDI equipment can normally be
"tuned" to receive MIDI data on any one of 16 channels, much like a
television set can tune into different TV stations.

MIDI EVENT

A piece of inforrmation sent over MIDI as one "message". Examples of MIDI
events are; Note On, Note Off, Tune Request, Patch Change, etc. When using
a pitch wheel, one MIDI event is one movement of the pitch wheel, not the
whole bend (which may consist of hundreds of events).

MIDI IN/OUT/THRU

The means by which MIDI equipment is connected. MIDI data is
transmitted out the MIDI Out port. MIDI data is received on the MIDI In
port. A MIDI Thru port (not the same as the sequencer's Thru function),
which is optional, provides an exact copy of the data arriving at the MIDI In
port with no timing delay. MIDI communication is possible when a cable is
connected from one device's MIDI In to another device's MIDI Out.
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MIDI SPEC

The MIDI 1.0 Specification is the official document that defines the MIDI
standard (both the hardware and the communication protocol). Copies can
be obtained from the IMA (International MIDI Association) in Los Angeles.

MIX
1. To establish relative volume levels, sound placement, EQ settings, and a
number of other details to produce a final, cohesive recording.

2. To combine (BOUNCE) several tracks together into one.

MONO MODE

A MIDI Mode where the voices in an instrument are subdivided one per
channel. For example, a Casio CZ-101 can be set up so that it can play one
note each on 4 channels, each channel having a different sound or timbre
(hence the term multi-timbral). Another use of Mono Mode is for
instruments designed to work with guitar controllers. By using a separate
channel for each string, a guitar controller can then handle the
independent pitch bending of each note. Also see POLY MODE.

MTR

Multi-Track Recorder. This can be any recording device with multiple tracks
4, 8, 16, 24, 32, or more), which allows recording on one track while playing
back others.

NUMERATOR

The top part of a fraction. Since time signatures are written in a style
similar to fractions (eg, 4/4), Numerator is also used to refer to the number
of beats in a measure (denominator then referring to the beat value).
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OMNI ON/OFF

Omni On is a mode in which a MIDI device receives and acts on MIDI
information on any of the 16 MIDI channels (ie, it ignores the channel
numbers on messages). This was often used in the early days of MIDI to
make hookups between two synthesizers (which might otherwise be set to
different channels and thus not communicate) simple.

Omni Off is the opposite mode, where the receiving MIDI device looks at the
MIDI channel on each message and only acts on messages on the
channel(s) it has been set for.

OVERDUB
The action of recording music on another track while playing back music
recorded previously on other tracks.

PATCH

A specific sound program on a synthesizer. Changing the patch on an
instrument means calling up a different sound from a stored definition.
Originally, synthesizer sounds were generated by connecting oscillators
and amplifiers together via patch cables, hence the term patch.

PITCH BEND

A means of varying the pitch of a note as it plays by using a controller such
as a pitch wheel. The maximum range of a pitch bend is determined by a
setting on the instrument.

PIXEL

Short for "picture element". The smallest unit of display on a computer
monitor, thus also the smallest possible unit of movement for the mouse.
On the Atari ST, the monochrome screen (high resultion) is 640 pixels wide
by 400 pixels tall. The color screen in medium resolution is 640 pixels wide
by 200 pixels tall.
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POLY MODE

A MIDI Mode where all the available voices (notes) in an instrument are
assigned to one MIDI channel. (A split mode or multi-channel mode,
available on some instruments, actually treats the device as multiple
"instruments”, each in Poly Mode on one channel.) Also see MONO MODE.

POLYPHONIC KEY PRESSURE
See AFTER TOUCH

PPQ

Pulses Per Quarter Note: how many steps a quarter-note is divided into,
either in sequencer storage (then often referred to as "TICKS per BEAT") or
in synchronization. The internal storage of EZ-Track Plus is 96 ppq. MIDI
Clock synchronization has one-quarter that resolution, since it is 24 ppq.
Also see CLOCKS.

PSEUDO NOTE OFF

The MIDI SPEC allows for the turning off of a note to be represented in two
different ways. One way is by an actual ('real") Note Off message, which
includes a RELEASE VELOCITY value. The other method is to send it as a
Note On with a velocity value of 0. All instruments should interpret either of
these messages as a command to turn off the note.

PUNCH IN / PUNCH OUT

The action of replacing information on a track between a Start Time and an
End Time. On simple multi-track recorders, you Punch In (record on the
Punch track) by pressing a switch, and Punch Out (stop recording on that
track while continuing to roll the tape) by letting up on the switch. In
advanced MTRs and most sequencers, you can predetermine the Start Time
and End Time, and have the track automatically mute and go into record at
those points. Also known as Automated Punch.
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QUANTIZE

To correct the timing of a performance. For example, by quantizing a track
to quarter notes, all notes on the track that are not on exact quarter-note
beats will be placed on the nearest beat. If the timing was too far off to start
with, though, the "correction" can move some notes in the wrong direction.

RAM

Random Access Memory. That portion of a computer's memory used for
temporary storage of changeable information, as opposed to ROM (Read-
Only Memory) which is unchangeable memory. Unless battery-backed-up,
RAM ‘"forgets" when the computer (or device essentially containing a
computer, as most modern instruments do) is turned off.

RELEASE VELOCITY

The speed with which you release a note. Some synths recognize this MIDI
parameter (sent as part of a "real" Note Off message) and allow for different
effects depending on the release of the key. Also see PSEUDO NOTE OFF.

ROM

Read Only Memory. Memory that is not lost when the computer (or other
device) is powered off (and needs no battery backup) and is unchageable
(except, perhaps, by replacing the ROM chips).

SECTION
A defined portion of a track (or multiple tracks) that can then be pasted
(Glued) to another point in the song.

SLAVE
In synchronization, a device that receives its timing from (is under the
control of) another device (the MASTER).

STEP RECORD
To record MIDI information by stepping through time manually, inputting
events one piece at a time.
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UNMIX
To separate note values from a specified track by MIDI channel assignment.

VELOCITY

The speed at which a key travels as you press it (if referring to Attack
Velocity). In practice, this is essentially a representation of how hard you
strike the key. Most synthesizers (the least-expensive ones are the
exception) are velocity sensitive, and can generate a variety of effects
(increase in volume, brightness, etc) based on an increase in velocity. Also
see RELEASE VELOCITY.



APPENDIX K
Key CoOMMAND LisT

This Appendix Lists:

e All keyboard commands which
make it possible to perform many of
the functions available using the
Atari ST keyboard
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In reference to the Commands listed on the following pages:

Control means HOLD DOWN the Control key, then press the letter

Shift means HOLD DOWN the Shift key, then press the letter

Alternate means HOLD DOWN the Alternate key, then press the letter

In some cases, combinations of the above special keys are held down at
the same time

¢ Numeric refers to a key on the Numeric Keypad
¢ All other keys or mouse buttons as they appear
For example,

Control Shift O

means:

While holding down the Control and Shift keys, press O on the main
keyboard. (If a key is used from the Numeric Keypad, it would say Numeric.)



Menu Commands
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OPERATION FROM THIS MENU: ST KEYBOARD:
Current Drive File Menu Alternate C
Delete File File Menu Alternate D
Format Disk File Menu Alternate F
Import Track File Menu Alternate I
Load Song File Menu Alternate L
Quit File Menu (no key equivalent)
Save Song File Menu Alternate S
Update File Menu Alternate U
Delete Track Track Menu Control Shift D
Glue Section Track Menu Control G
Name Track Track Menu Control N
Protect Track Track Menu Control P
Unprotect Track Track Menu Control Shift P
Copy Track Edit Menu Control C
Erase Song Edit Menu Control Shift E
Mix Tracks Edit Menu Control M
Name Song Edit Menu (no key equivalent)
Quantize Track Edit Menu Control @
Transpose Track Edit Menu Control T
Unmix Track Edit Menu Control U
Velocity Adjust Edit Menu Control V
Track Delays Options Menu Control -
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Track Display Commands

OPERATION CLICK MOUSE ON: ST KEYBOARD:

Select A Track Track Pointer 1-0, Shift 1-0
Up/Down Arrow

Unmute (Track ON) Track Arrows (L) Shift Up Arrow

Mute (Track OFF)
Solo (Only Track ON)
Bow-Out

(Only Track OFF)
Unmute All Tracks
Mute All Tracks

Track MIDI Channel

Track Arrows (R)
Track Arrows (L+R)
Track Arrows (R+L)

MIDI Channel
Column (L/R)

Shift Down Arrow
Control Up Arrow
Control Down Arrow

Control Shift Up Arrow
Control Shift Down Arrow

Control 1-0
Control Shift 1-6
Control Shift O
Shift [ OR ]
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OPERATION CLICK MOUSE ON: ST KEYBOARD:
Tempo:

(Fine) Tempo Value . OR,

(Coarse) Tempo Quarter Note | Shift. OR,
Metronome ON/OFF Speaker Icon !
Sync Type Sync Icon Shift '
Activate Auto-Locate Locate Bar Numeric *
Activate Punch Punch Icon Numeric /
Reset Counter Reset Icon Control Space Bar
Step Time:

(Beat) Counter L of dot Shift Tab

(Clock) Counter R of dot (L) Control Tab

(16ths) Counter R of dot (R) /

Transpose Global:

(by Half-Step)

(by Octave)
Transpose Exception
Thru ON/OFF
Thru MIDI Channel

STOP

PLAY
PAUSE/Continue
KEEP recorded info

Turn Off sustain notes

Accidental Column
Transpose Icon
Transpose Ch Icon
Thru Box

Thru Ch Icon

Stop Icon
Play Icon
Pause Icon
KEEP Icon

Left/Right Arrow
Shift Left/Right Arrow
Control Shift [ OR ]

[OR]

Return

Space Bar

Tab

Shift Enter

Enter (with Safety OFF)

Control X
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APPENDIX R
MEeENU BAR REFERENCE

In This Chapter:

Desk Menu
File Menu
Track Menu
Edit Menu
MIDI Menu
Options Menu
Safety Menu
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Across the top of the screen lies the Menu bar, where all the options of EZ-
Track Plus can be accessed. This chapter gives a brief description of each of
the functions and directs the user to the chapter and gives a brief
explanation of it's function. This can serve as a quick reference for
experienced users or provide a place to refer to functions as they're laid out
on the screen, as opposed searching through the manual for the answer.

DESK MENU

About EZ-Track+  This lists the credits for the program (general software
practice showing author, publisher, and version).

This menu selection can also be used to release some
(very few) desk accessories which don't give control
back to EZ-Track Plus after they are closed. Select
About EZ-Track+ if, after using a desk accessory, you
find that menu selections are still disabled (can't be
used).

GenPatch A Desk accessory that allows loading of Hybrid Arts'
GenPatch files into your synths without having to exit
the program.

CHAPTER 6
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FILE MENU

Load... Loads in a previously saved song.
CHAPTER 3

Import Track... Allows the merging of files through selecting individual
tracks and combining them with the current song
you're working with.
CHAPTER 4

Save As... Saves the current song you're working with to disk,
prompting you to enter a name for the file.
CHAPTER 3

Update Saves the current song you're working with to disk
without prompting you for a file name. You must have
saved the current file once within the period you've
been working with it for this option to become available.
CHAPTER 3

Delete... Allows (permanent) deletion of files of any kind on
disk.
CHAPTER 3

Format Disk... Will format a disk, single or double density, on the

Current Drive

HybriSwitch

Quit

drive of your choice.
CHAPTER 3

Allows user to change the drive currently used to load
from and save files to.
CHAPTER 3

Allows access to other programs when running under
Hybrid Arts' HybriSwitch software. You can switch
between up to 10 programs by pressing a button.

(See your Authorized Hybrid Arts Dealer for details)

Exits the program back to the desktop.
(No detailed description needed)
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TRACK MENU

Name Allows naming of individual tracks.
CHAPTER 3

Protect Prevents accidental erasure of track information when
on.
CHAPTER 3

Unprotect Turns off the protect feature.

Glue Section

Delete

CHAPTER 3

The cut-and-paste feature. Copies any portion of a
track or tracks that have been defined by the user,
from one timing location to another, as specified.
CHAPTER 5

Erases the track currently selected.
CHAPTER 3
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EDIT MENU

Name Song Permits a name to be assigned for the overall song (not
to be confused with a file name).
CHAPTER 6

Copy Track Copies a specified track to another track, erasing
anything present on the destination track.
CHAPTER 4

Mix Tracks Mixes one or more tracks to another specified track,

Unmix Tracks

Quantize Track

Transpose Track

Velocity Adjust

Erase Song

including any MIDI channel assignments, delays, etc.
CHAPTER 4

Separates out information on a track by MIDI channel
assignment.
CHAPTER 4

Autocorrects the timing to any reference value without
altering the information on the original track.
CHAPTER 4

Transposes notes on a track by half-steps, plus or
minus 9 octaves.
CHAPTER 4

Permits adjustment of velocity values contained on a
track.
CHAPTER 5

Deletes the current song from memory.
CHAPTER 6
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MIDI MENU

Send Mode Msg

Input Filters

Output Options

Allows a variety of MIDI Mode messages to be sent over
specified MIDI channels.
CHAPTER 6

Gives the user control over which types of MIDI
information is to be recorded and allows filtering out of
unwanted events.

CHAPTER 6

Provides several different MIDI output sync variations
to ensure more synth and drum machine
configurations are covered.

CHAPTER 8
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OPTIONS MENU

Meter/Metronome Toggles back and forth between a display of meter or

Quantize Method

Whole vs Region

Track Delays

beats in the counters, and allows setting up of time
signatures.
CHAPTER 5

Selects between two methods of quantizing (Move Note
or Shift Attack.)
CHAPTER 6

Lets you determine whether or not a query to alter the
whole track or only a specified region of the track will
appear each time an edit takes place.

CHAPTER 4

Adjusts the timing of tracks relative to each other, late
or early by ticks.
CHAPTER 4
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SAFETY MENU

Entering Menu

Shift + Enter

Deleting

Replacing

Back Up Files

Either you may enter the Menu bar directly, or only by
clicking the Left mouse button.
CHAPTER 6

Either the Shift key alone or a combination of Shift +
Enter is required when using the ST keyboard to store
MIDI information to a track.

CHAPTER 6

Either the user is warmed or not when deleting a track.
CHAPTER 6

Either the user is warned or not when replacing a
track.
CHAPTER 6

You may choose whether to automatically create
backups for your songs whenever you save your files to
disk, or not.
CHAPTER 6



APPENDIX T
TROUBLESHOOTING

This is a troubleshooting chapter.
It is a compilation of the most
commonly overlooked situations
which can be corrected easily.
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Problem

e The Disk Drive has
problems reading the
disk.

e The disk may be
damaged.

e There may be dust on
the disk.

¢ It may not be aligned
properly.

* The spring in the disk
shutter may be stiff.

v

Data on the disk in drive A:
may be damaged. You must use
the right kind of floppy disk;
you must connect your hard
disk properly,

[Cancel | | Retry |

e MIDI Out data seems to
be doubled up or garbled
when using MIDI In/Out
ports.

¢ The computer crashes
when an underscore ()
is typed in a dialog box.

¢ The Atari ST MIDI Out
port uses pins 1 and 3
for MIDI Thru. Pins 4
and 5 are the two signal
pins in MIDI. Some cable
manufacturers cross
connect pins 1 and 3 to
these wires causing
"MIDI feedback".

e A GEM bug occurs in
ROM versions through
11/20/85. Newer ROMs
are installed in the
MEGA ST computers.

e Play with the disk
shutter and spin the
disk inside its casing
manually (by rotating
the metal hub) then
Retry.

¢ Try the same disk on
a different drive.

¢ Use MIDI spec cables.
e Try another brand of
MIDI cables.

e Don't type in an
underscore in dialog
boxes wunless you
understand where the
underscore will work
(for example, they
won't work any time a
number is requested).



Problem

e Computer crashes
when a disk error
occurs.

e When the program is
loaded, sometimes the
key click chatters
continuously (monitor
volume turned up).

e The metronome can't
be heard even though it
is enabled.

¢ Menus fail to drop.

¢ The menu sticks when I
get part way down the
menu and none of the
functions can be
selected.

APPENDIX T  TROUBLESHOOTING

Possible Cause

* Repeated disk errors
(such as no disk in drive)
can sometimes lead to
system hangups.

¢ If you move the mouse
while the program is
loading, it may get the
computer confused.

* Monitor volume down.

* GEM

* GEM

7-3

Possible Soluti

¢ After getting one error
such as no disk in
drive, it's safest to save
the song file and reset
the computer as soon
as possible.

¢ Hit the Esc key

¢ Turn up your monitor
volume.

¢ Click the Left button
once while pointing at
the menu bar.

e Move the mouse back
up into the menu bar
and then retry.
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Problem Possible Cause

e The date and time on|e The date and time are
some songs comes up |displayed only if valid
blank. (later than 1985).

- I'm Without a Date Tonight
version 2 |

I Finally Got a Date!
version 3 | 04-22-88 B84:37 pn

e Some .SNG files won't|® The song could have

load. been created with a
different program. Some
other sequencers also
create files with the
.SNG extension.

Song not loaded successfully,

o

e GenPatch Accessory is
not in the Desk menu.

e The Accessory was not
properly loaded.

Possible Solution

* Use the Control Panel
accessory to set the
correct date and time.
When you turn your
computer off, it loses
the time unless you
have a battery backed-
up clock.

e You can only load
.SNG files created with
Hybrid Arts programs.

* Refer to page 6-4 for a
detailed description of
loading accessories.



Problem

* Every time the song
plays, my instruments
change patches but I
don't want them to.

* Some notes don't seem
to play on my MIDI
instrument.
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Possible Cause

e Patch changes are
recorded the same way
as Note Events. When
the sequence gets to a
patch change event, it
changes the patch
setting on the assigned
instrument.

¢ Some inexpensive MIDI
instruments can only
play a limited number of
notes simultaneously.
These is a limit of the
instrument, not the
sequencer. (Observe the
Track Activity Indicators
to get an idea of how
many notes are being
played at one time.)

T-5

Possible Solution

* Don't change patches
while you are recording
the music. Instead,
record all music with
one patch setting (you
may want to filter
patch changes -- MIDI
Input Filters option).
Then go back and
record all the patch
changes on a separate
track. You can then
turn off the patch track
and the patches won't
change.

e Optionally (but more
tediously) you can step
through the sequence
by beats or ticks to find
suitable Punch-In/Out
times for removing
patch changes one by
one.

e If the instrument has
Mono Mode (also called
solo mode), this causes
it to play only one voice
at a time per channel.

e Some instruments
have different patch
settings. One patch
may play 8 voices at
once; another may only
allow you to play up to
4 notes. Be aware of
these settings.
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Problem

e The song I saved

doesn't appear on my
disk when I try to reload
it.

e When I load my song
in, I don't get the most
current version.

Possible Cause

* You may have named
the song with an
extension other than
SNG.

e It is possible to save
different versions of the
same song to different
disks with the same
filename.

Possible Soluti

e The filename is 8
characters long. The
extension consists of
the 3 characters after
the period. When you
name your song, be
sure to only use the
first 8 characters.

¢ Quit the program and
rename your song with
an .SNG extension
(refer to Renaming
Files in your Atari
owners manual).

e Make sure you have
the correct disk in the
drive.

* Also be aware of the
Current Drive setting
and make sure you are
accessing the correct
drive.



Problem

e A message says that
the MIDI input buffer
overflowed.
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Possible Cause

e If continuous MIDI
information is being
received at the MIDI
input, selecting a menu
or dialog box may cause
the MIDI memory buffer
to overflow. The source
of this continuous data
may be Clock from a
drum machine, or data
from a loose joystick,
wheel, or lever on your
keyboard.

MIDI input buffer overflowed,
Data in KEEP buffer may be bad.

* The KEEP button lights
when you're not doing
anything.

e Some sort of MIDI
information has been
received. The source
may be data from a loose
joystick, wheel, or lever
on your keyboard.

T-7

Possible Soluti

e If the source of the
continuous data is a
drum machine, disable
MIDI Clock output on
it.

e If the source is a loose
pitch wheel and you
don't need to record
pitch bend, filter Pitch
Bend (using the MIDI
Input Filters option in
the MIDI menu).

e If the source is a
joystick, wheel, or lever
other than pitch bend,
and you don't need to
record any continuous
controllers, filter out
Controllers.

e You can ignore the
problem in most cases,
as it usually occurs
when you don't have
important data in the
KEEP buffer anyway.

* Filter Pitch Bend
and/or Controllers (in
the MIDI Input Filters
option) if you don't
need to record those
types of events.

¢ The KEEP buffer will
be cleared when you
click on PLAY to start
recording.
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Probl

¢ While I'm recording or
editing, a memory limit
message appears.

e The KEEP buffer's
capacily has been
exceeded by MIDI input,
or there wasn't enough
unused memory to hold
the temporary data
needed during an edit
operation.

@ Hemory limit exceeded!

¢ If you want to play on
your keyboard while
EZ-Track Plus is not
playing, click on the
Counter Reset Button
to reset the counter to
the beginning of the
song. If the counter is
at 00000.00 and the
KEEP buffer overflows
from MIDI input, no
message will be shown,
and EZ-Track Plus will
automatically clear the
KEEP buffer.

e If a track edit runs out
of memory, you need to
either delete some
unnecessary tracks, or
make more memory
available to EZ-Track
Plus (after quitting).
See page 3-7 for a note
about song memory

capacity.
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Mix Tracks 3-3; 4-3, 13; R-5
Multiple Instrument Setups 6-7

N
Name Song 3-3; 6-14; R-5
Non-Destructive Editing 3-9

O

Output Options 3-3; 7-2; R-6
Overdubs 3-24

Overview 1-2



P

Package Contents 2-2
PAUSE 3-19
PLAY/RECORD 3-17, 19
Punch-In / Out 3-24

Quantize Method 3-3; 6-1
Quantize Track 3-3, 4-3,
Quit 3-3, R-3

17; R-7
5 R-5

R
Record Buffer 3-17; T-7
Recording
Controls 3-18
Music 2-7
Overdubs 3-24
Step Time 3-31
Region 4-10
Release Velocity 5-3
REWIND (See
FORWARD /REWIND)

S
Saving Song Files 3-3, 35; R-3; T-6
Screen, The EZ-Track Plus 3-2
Section
Creating A Section 5-12
Glue 5-16; A-2
Send Mode Msg 3-3; 6-11; R-6
Shift + Enter 3-3; 6-18; R-8
Song Files (See also Files)
AUTOLOAD 6-15, 16
AUTOPLAY 6-15
Back Up Files 3-3; 6-20; R-8
Compatibility 3-37; T-4
Deleting 3-3, 38; 6-19; R-3, 8

INDEX

Loading 3-3, 36; R-3; T-4
Naming 3-35
On Master Disk 2-2
Replacing 3-3; 6-19; R-8
Saving 3-3, 35; R-3; T-6
Updating 3-3, 36; R-3

Song Position Pointer 7-3, 4

Songs
Erasing 3-3; 6-16; R-5
Naming 6-14

Start Time 3-21

Step Recording 3-31

STOP 3-19

Sync Type 7-4

System Requirements 1-6

T

Tempo Setting 3-29

Thru Function 6-7, 8

Ticks 3-32; 4-7; 5-7

Track
Assigning MIDI Channels 3-16;

4-14
Copy 3-3; 4-3, 12; R-5
Delays 3-3; 4-17; R-7
Deleting 3-3, 15; R-4
Display 3-4
Import 3-3; 4-3, 19; R-3
Keeping 3-4, 20
Mixing 3-3; 4-3, 13; R-5
Muting 3-14
Naming 3-3, 12; R-4
Protecting 3-3, 13; R-4
Quantizing 3-3; 4-3, 5; R-5
2

Selecting 3-10; 4-

Transposing 3-3; 4-3, 8; R-5

Unmix Track 3-3; 4-3, 15; R-5

Unprotecting 3-3, 13; R-4

Velocity Adjust 3-3; 4-3; 5-2;
R-6

Transpose, Global 6-2
Transpose, Track 3-3; 4-3, 8; R-5



EZ-TRACK PLUS USER MANUAL

U
Unmix Track 3-3; 4-3, 15; R-5
Updating Song Files 3-3, 36; R-3

Vv

Velocity
Adjust 3-3; 4-4; 5-2; R-5
Shift 5-3, 4
Set 5-3, 6

w
Whole vs Region 3-3; 4-10; R-7



Information Report Sheet

We are constantly improving our products. Any suggestions or problems
you bring to our attention would aid in assuring you receive the finest
quality product possible. Please write down your ideas, fill out the following
information, and mail it all to Hybrid Arts, Inc. Product Support Division,
11920 W. Olympic Blvd., Los Angeles, CA 90064.

[Your Address

Name

Street

City State ZIP

[Hybrid Arts Product Description

Name Warranty #

Version/Release

|Addtional Information

Other Software Being Used

Additional Desk Accessories
and/or AUTO Folder Programs
Being Used (Non-Hybrid Arts)

IYOUI’ Computer/Studio Set Up (Circle equipment you currently use) I

c ter T Monitor T Disk Drive C it i .
520 ST Color Single-Sided Drive B
1040 ST Monochrome Double-Sided Hard Disk
MEGA 2 Size: Meg
MEGA 4

Extra RAM (amount): . Printer Model:

Peripherals:




[Problem Description

If you can provide any addtional information (exact steps to repeat problem,
Alt-Help screen dumps, etc.) it would be greatly appreciated.

Hybrid Arts Technical Department Use




Hybrid Arts Product Support

Hybrid Arts provides phone assistance to registered users of their software.
To be eligible for phone support, you must return the registration and
warranty card that comes with your package. Hybrid Arts support
specialists are available to answer questions related to any Hybrid Arts
software products, but before you call, please follow this procedure:

Review the section of the manual containing the information on the
operation you are trying to perform. Check before this section for any
misunderstood words or symbols and clear up any you find to your
satisfaction. Restudy the section you were having difficulty with and see
if it doesn't make more sense.

If you still can't make your Hybrid Arts Product perform as you desire,
please write down the exact problem or question in detail so that you can
convey this to the support specialist.

Please Write To:

Hybrid Arts, Inc.
Product Support Division
11920 W. Olympic Blivd.
Los Angeles, CA 90064

Hybrid Arts
Product Support
Talk Lines
(USA): (213) 826-3777
Calling hours: Monday-Wednesday-Friday 12:00 - 4:00 PM pst

Additiongl S |

There is also a Hybrid Arts Bulletin Board Service. This is a service available
via modem. Leave questions about specific products or general questions
regarding MIDI. Our Support Specialists' answers are quick and direct.

Hybrid Arts
Bulletin Board Service
(USA): (213) 826-4288



Hybrid Arts Product Philosophy

You are our most valued customer. By purchasing this program and sending in the Warranty Card, you
will become a part of our priority support/upgrade system that insures continued access to state of the art
music technology. The Hybrid Arts Upgrade and Support System works in 3 ways:

1. The Upgrade System
For all programs that have an upgrade path, a warranty owner with the proper card on file can
purchase the more advanced program for the increase in retail plus a $15-$25 upgrade fee. Updates
(new versions of the same program) can be obtained for just the upgrade fee.

2 The Free BBS System
Hybrid Arts has a 24-hour computer Bulletin Board Service called the MIDI World Network. This can
be connected to via modem and will allow access to all kinds of MIDI information as well as
thousands of DX, CZ, and other popular instruments' patches. These sound files can be downloaded
for use in your synths. The system also has song files that can be downloaded for use with EZ-Track
Plus and MidfTrack ST. The MIDI World Network BBS number is 213-826-4288.

3. The Help System
Hybrid Arts offers over-the-phone technical support to warranty owners. If you have read both
owners manuals (the one supplied with this Hybrid Arts product and the one supplied with your MIDI
keyboard) and are still experiencing difficulty, call the Hybrid Arts office number 213-826-3777 and
ask for technical support. The hours for technical support are MON-WED-FRI from 12 to 4, Pacific
Time.

Hybrid Arts Product List (now available)

ADAP SoundRack (Analog to Digital Audio Processor)
16-bit, 44.1kHz stereo sampling, editing. Writes direct to hard disk for digital mastering. SMPTE-
triggerable samples. Reads most of the standard sampler disk libraries that already exist.

SmpteTre *k & SyncTrack from the MidiTrack ST Series

60 tracks  'x, ur nx, transpose, changing tempos/meters, Graphic Editing allows redrawing of pitch
bend-aftertouct _.ocity-controllers, Text Editing, etc. SmpteTrack includes SMPTE time code
read/write capabyu tHes.

EZ-Track Plus

The new 20-track polyphonic MIDI recorder for the ATARI ST. This program includes such features as
Punch-In / Punch-Out, Cut & Paste, Auto-Locate, Mix & Unmix, allows both real time and step time entry
from the MIDI keyboard, Insta' * -anspose, Quantizing, and a .5 to 480 BPM tempo range.

DX-Android & CZ-Android

These two programs are making the task of programming MIDI fnstruments very easy. They both contain
Artificial Intelligence algorithms that generates new patches by itself. The DX-Android works with the
DX-7 and the TX-ToneRack Modules. The CZ-Android works with the CASIO CZ- synthesizer series.

EZ-Score Plus
Professional Music Printing is essential to a complete studio system. This program allows you to achieve
that flexibilty: over 100 music symbols, Lyrics, convert sequence files.

HybriSwitch
Have ALL of your programs in memory at the same time. Then just press a buttor tn switch between them.
Runs with most applactions. For more information, contact Hybrid Arts.

MIDIPLEXER
This hardware bax expands your Atari to 2 MIDI Ins, 4 MIDI Outs, and 64 separate MIDI Channels (when
used with any of the MidfTrack ST sequencers). For more information, contact Hybrid Arts.

For a complete updated CATALOG & NEWSLETTER, Write To:
Hybrid Arfs, 11920 W. Olympic Bivd, Los Angeles, CA 90064






®) Hybrid Arts,inc:

11920 WEST OLYMPIC dOULEVARD * LOS ANGELES. CA 90064
OFFICE: (213) 826-3777 « COMPUTER: (213) 826-4288
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